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4 RealFlight 9.5 RC Flight Simulator 

 

Introduction 

WELCOME TO THE REALFLIGHT 9.5 RC FLIGHT SIMULATOR 

 

ealFlight 9.5 RC Flight Simulator is without question, the most advanced RC aircraft 

simulation available. It ƛǎ ǎƻ ǘŜŎƘƴƻƭƻƎƛŎŀƭƭȅ ŀŘǾŀƴŎŜŘ ŀƴŘ ǎƻ ǊŜŀƭƛǎǘƛŎΣ ȅƻǳΩƭƭ ŦƛƴŘ ƛǘ 

hard to believe ǘƘŀǘ ƛǘΩǎ ƻƴƭȅ ŀ ǎƛƳǳƭŀtion. The culmination of over twenty three years 

of development and design, RealFlight 9.5 offers advancements that will serve to fine-tune 

the flying skills of even the most seasoned RC veteran. LŦ ȅƻǳΩǊŜ ŀƴ ŜƴǘǊȅ-level RC-er, 

RealFlight 9.5 is the ideal way to learn to fly, practice maneuvers, feel the effects of design 

modifications, or just have an incredible amount of fun.  Thanks to the incorporation of 

groundbreaking Spektrum AS3X ® and SAFE® stabilization technology, found in many of the 

additional Horizon Hobby aircraft, a better flying experience is available for a wider range of 

RC pilots. 

RealFlight 9.5 includes over 160 models that look and fly like the real thing, plus a multitude 

of flying sites όŜŀŎƘ ǿƛǘƘ ǘƘŜƛǊ ƻǿƴ ǳƴƛǉǳŜ άŦŜŜƭέ ŀƴŘ ŘƛǎǘƛƴŎǘƛǾŜ ŎƘŀǊŀŎǘŜǊƛǎǘƛŎǎύΦ In addition, 

RealFlight 9.5 offers its users the most powerful, flexible aircraft and flying site editors ever 

unveiled to the modeling community; allowing modelers to experiment with a virtually 

unlimited number of parameters. RealFlight 9.5 enables you to change the look and feel of a 

flying site with nothing more than a few keystrokes, a click of the mouse and a little 

imagination. ¢ƘŜ ƛƴǘŜƎǊŀǘŜŘ !ŎŎǳaƻŘŜƭϰ ŀƛǊŎǊŀŦǘ ŜŘƛǘƻǊ ƳŀƪŜǎ ƳƻŘƛŦȅƛƴƎ ŀƛǊŎǊŀŦǘ Ƨǳǎǘ ŀǎ 

easy. 

RealFlight 9.5 also offers a wide array of tools to help you understand how to use the 

program and how to improve your RC piloting skills. This extensive manual explains every 

feature and option; as well as how to use them. We offer a number of training aids and 

assistance including (but not limited to): our Heli Hover Trainer, Airplane Hover Trainer, Heli 

Autorotation Trainer and Heli Orientation Trainer. Horizon has also included updated flight 

training lessons to assist new airplane pilots in the enjoyment of the hobby!  These helpful 

training aids provide on-the-fly learning opportunities, and we encourage you to take full 

advantage of them. No other RC simulator goes further to enrich your RC experience. 

Chapter  

1 
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The following section briefly outlines some of the exciting features in RealFlight 9.5. 

Subsequent chapters will describe all RealFlight features in complete detail. We strongly 

suggest that you peruse this manual in its entirety, as it explains every feature and option, as 

well as how to use them.  

CƛƴŀƭƭȅΣ ǿŜΩŘ ƭƛƪŜ to express our gratitude to you for purchasing RealFlight. We think you will 

be enormously pleased with RealFlight 9.5. Have fun flying! 

Please note that while this manual has been written from the perspective of the RealFlight 

9.5 iteration of the software.  If, however, you are using a previous version of the simulation, 

most of the features and functions are still applicable as are the steps/procedures to access 

accordingly. 

RealFlight 9.5 Feature Highlights 

This section briefly outlines some of the features included in the RealFlight 9.5 RC Flight 

Simulator with the Spektrum® InterLink DX Controller.   

USB Spektrum InterLink DX Controller- 

New to the RealFlight 9.5 software is the recently developed Spektrum InterLink DX 

Controller.  The multi-patented InterLink DX controller has been optimized for use within the 

simulation and incorporates a significant number of enhancements and improvements over 

previous RealFlight systems and control methodologies. 

The InterLink DX Controller is a revolutionary device that offers you the following: 

¶ A high-quality USB controller for RealFlight 9.5; backwards compatible to RealFlight 8 

software releases, should you choose to do so.    

¶ A built-in interface for (optionally) using your own RC transmitter to control 

RealFlight. 

¶ vǳƛŎƪ{ŜƭŜŎǘϰ .ǳǘǘƻƴǎτǘŀƪŜ ŎƻƴǘǊƻƭ ƻŦ wŜŀƭCƭƛƎƘǘΩǎ ƳŜƴǳǎ ŀƴŘ ƻǇǘƛƻƴǎ ŦǊƻƳ ǘƘŜ 

InterLink DX without touching the keyboard or mouse. 

¶ The InterLink DX Controller is fully hot swappableτyou can connect and disconnect the 

InterLink DX or your own transmitter without rebooting your computer (or even 

shutting down RealFlight). 

¶ 15 Channels- including two slider controls, 2 two-position switches, 5 three-position 

ǎǿƛǘŎƘŜǎΣ м ƪƴƻō ŀƴŘ м ΨtŀƴƛŎΩ ōǳǘǘƻƴΦ 

¶ High-speed response to control inputs. 

¶ Digitally precise inputs with digital trims for unmatched control precision. 
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¶ A keyboard-free push button reset of the simulation. 

¶ Instantly rewind your current flight and start over from any point. 

¶ The ability to hand launch aircraft. 

Horizon Hobby AS3X and SAFE Technology- 

New to the RealFlight 8 Horizon Hobby Edition, RealFlight 9.5 continues to expand the selections 

and offerings that include exclusive groundbreaking technology from Spektrum.  Incorporating 

SAFE Select and AS3X in a multitude of models within this iteration ensures not only success for 

entry-level modelers but also a better flying experience for a wider range of pilots regardless of 

skill sets. 

AS3X enhances the flight performance of models stabilizing the aircraft in whatever attitude the 

pilot commands.  Countering external forces such as wind, torque, tip-stall, etc. our AS3X 

technology uses a combination of flight sensors to ensure a pleasant flying experience. 

SAFE Select is a complementary technology to the AS3X flight performance.  With the flip of a 

switch, SAFE Select is active and limits the pitch and roll angles keeping the aircraft airborne and 

eliminating any fears.   

USB interface- 

RealFlight 9.5 is also backwards compatible for users that have purchased previously offered 

RealFlight interface options.  These items offered a simple method to use your own 

transmitter without a lot of fuss. Like the InterLink DX, these interfaces are plug-and-play for 

quick installation. If you own one, the wired interface allows you to connect most popular 

radios through the trainer ports that are PPM compatible. Alternatively, there was also a 

wireless interface available.  This wireless interface works perfectly with SLT transmitters, like 

Tactic radios, or any radio utilizing the AnyLink adapter. 

Spektrum users will appreciate the currently offered Spektrum WS2000 wireless simulator 

dongle (Horizon SKU SPMWS2000), allowing modelers to control the action with a Spektrum 

DSM2 or DSMX-compatible transmitter.  We will fully delve into the advantages and options 

ǿƛǘƘ ǘƘŜ ²{нллл ǿƛǊŜƭŜǎǎ ǎƛƳǳƭŀǘƻǊ ŘƻƴƎƭŜ ŜƭǎŜǿƘŜǊŜ ƛƴ ǘƘƛǎ ƳŀƴǳŀƭΦ  LŦ ȅƻǳΩŘ ƭƛƪŜ ǘƻ ǳǎŜ 

your Spektrum, or Spektrum-compatible transmitter with RealFlight, please refer to the 

applicable section of the manual for information on how to do so.     

Menu-Driven Interface- 

RealFlight 9.5 utilizes a drop-down menu-driven interface system. Created for ease of use 

and maximum flexibility, the menu system provides an interface familiar to even a casual 

computer user. 
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Additional Features- 

¶ Virtual Reality ς RealFlight 9.5 is compatible with the Oculus Rift and HTC Vive, 

popular VR Goggles. 

¶ wŜŀƭtƘȅǎƛŎǎϰ 3D- One of the most ambitious models of flight in the world, 

RealPhysics 3D is unmatched in its ability to re-create the lifelike characteristics of 

model flying. RealFlight 9.5Ωǎ ǇƘȅǎƛŎǎ ŜƴƎƛƴŜ Ƙŀǎ ōŜŜƴ ǘǊƛŜŘ ŀƴŘ ŀǇǇǊƻǾŜŘ ōȅ Horizon 

IƻōōȅΩǎ ƻǿƴ world-class competition pilots like Ali Machinchy, David Payne, James 

Haley, Dustin Buescher as well as many others.  Furthermore, aircraft in RealFlight 

behave with real-world predictability because they are carefully modeled using 

advanced methods and extensive real-world data. If it happens at the field or in the 

ŀƛǊΣ ƛǘΩǎ ǊŜ-created with exacting detail in RealFlight! 

¶ Challenges- These game-like events provide a fun way to test and develop your skills. 

Each has multiple levels. Difficulties increase as you move from one level to the next. 

Successfully earning a medal in each challenge unlocks new content. 

¶ Ghost Runs- Compete against your best time in the Challenges with ghosted images 

of your flights, pushing you to complete each level faster. 

¶ Float Fly- RealFlight offers a number of flying sites with water along with a variety of 

float fly aircraft. In fact, RealFlight 9.5 even includes E-CƭƛǘŜΩǎ Habu STS 70mm EDF- an 

incredible foray into EDF flight! Practice takeoffs and landings with this electric 

ducted fan without fear of crashing your R/C model.   

¶ Instant Rewind- Test your pattern flying over and over again with the Rewind 

feature. Hold the Reset button and watch your flight rewind. Let go of the button at 

the point you wish to re-start your flight. Use the data lever on the controller to seek 

forward or backwards through your flight. 

¶ InterLink DX vǳƛŎƪ{ŜƭŜŎǘϰ- With RealFlightΩǎ LƴǘŜǊ[ƛƴƪ DX controllerΣ ȅƻǳΩǊŜ ŀōƭŜ ǘƻ 

make quick changes such as, selecting a different aircraft or airport without touching 

the keyboard or mouse. First introduced in RealFlight 9.5, the scroll selection wheel 

which makes it even easier- and faster- to make your in-sim selections.   

¶ Quick Load- Know the name of the aircraft or flying site you wish to use? Open the 

Quick Load gadget to quickly search and load the aircraft. 

¶ Quick Edit- If you ever wish to make minor refinements ǘƻ ǘƘŜ ŀƛǊŎǊŀŦǘΣ ōǳǘ ŘƻƴΩǘ ǿƛǎƘ 

to dive into the complexity of the full aircraft editor, the Quick Edit is the solution for 

you! 

¶ Training Videos-Access the built in video player to training and feature videos.  For 

RealFlight 9.5 ǿŜΩǾŜ ŜǾŜƴ ŜȄǇŀƴŘŜŘ ǘƘŜ CƭƛƎƘǘ ¢ǊŀƛƴƛƴƎ ǘǳǘƻǊƛŀƭǎ ǘƻ ŜƴǎǳǊŜ ǎǳŎŎŜǎǎ ŦƻǊ 

new modelers.   
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¶ wŜŀƭ wŜƴŘŜǊƛƴƎϰ- Taking advantage of cutting edge 3D graphics technology, 

RealFlight not only flies realistically; it also looks true to life. 

¶ Variable Pitch Prop- Take 3D flight to 4D with the variable pitch prop. Select the 

FlatOutϰ 9ȄǘǊŀ олл{ ǿƛǘƘ ±-Pitch and try amazing maneuvers you dƛŘƴΩǘ ǘƘƛƴƪ ǿŜǊŜ 

possible with an airplaneτlike flying backwards. 

¶ Grappling Hook-Select the Skycrane heli to hook, grapple and drop objects. 

¶ Hovering Training Aids- [ŜŀǊƴ ǘƻ ǘƻǊǉǳŜ Ǌƻƭƭ ƻǊ ƘƻǾŜǊ ŀ ƘŜƭƛ ǿƛǘƘ wŜŀƭCƭƛƎƘǘΩǎ IŜƭƛ ŀƴŘ 

Airplane Hover Trainer. For more excitement, try the Heli Orientation Trainer. Both 

are great training aids for anyone new to radio control. 

¶ Overhead View- This on-screen gadget helps you find and line up to the runway for 

easier landings. Or use it to help find your friends during multiplayer sessions. 

¶ Sky Grid and Trails- Practice your precision maneuvers with these graphical aids. Sky 

Grid will display a pattern in the sky for reference. Enable Trails and you will see 

where your aircraft has flown; allowing you to perfect your maneuvers. 

¶ Night Flying- Wǳǎǘ ōŜŎŀǳǎŜ ǘƘŜ ǎǳƴ ƛǎ ŘƻǿƴΣ ŘƻŜǎƴΩǘ ƳŜŀƴ ǘƘŀǘ ȅƻǳ ŎŀƴΩǘ ŦƭȅΦ The same 

is true with RealFlight night flying. Pick a nighttime airport and watch as your aircraft 

lights up the sky. 

¶ PhotoFieldsϰ- RealFlight also includes ultra-realistic PhotoField airports. Using 

incredible high resolution digital images, RealFlight PhotoField airports are as real as 

it gets. In fact, RealFlight 9.5 even includes Eli Field, home to the Monticello Model 

aŀǎǘŜǊǎΣ IƻǊƛȊƻƴ IƻōōȅΩǎ ŀƴƴǳŀƭ w/ CŜǎǘ ŜǾŜƴǘ ŀƴŘ ǿƘŜǊŜ Ƴŀƴȅ ƻŦ ǘƘŜ IƻǊƛȊƻƴ 

IƻōōȅΩǎ ƳƻŘŜƭǎ ŀǊŜ ǘŜǎǘ Ŧƭƻǿƴ ŀƴŘ ŀǇǇǊƻǾŜŘΦ  New to RealFlight in this release is the 

ability to fly at the AMA (Academy of Model Aeronautics) headquarters in Muncie, 

Indiana.  Further, the Import feature allows you to use your own panoramic photos 

to create new flying sites. 

¶ άCǳƭƭ /ƻǾŜǊŀƎŜέ Ŏƻƭƭƛǎƛƻn detection- Instead of using sensors at only a few points 

along the aircraftΣ άCǳƭƭ /ƻǾŜǊŀƎŜέ ōƭŀƴƪŜǘǎ ǘƘŜ ŜƴǘƛǊŜ ŀƛǊŎǊŀŦǘ ǿƛǘƘ detection points 

ensuring that every part of an aircraft will not only register a strike but, will react 

authentically. Contact can result in damage ranging from minor handling problems to 

spectacular crashes complete with realistic sound effects. 

¶ TruFlo Wind Dynamicsϰ- RealFlight introduces modelers to RCΩǎ Ƴƻǎǘ ǊŜŀƭƛǎǘƛŎ ǿƛƴŘ 

model. All the components of TruFlo Wind Dynamics work together to create the 

single most accurate wind field in any simulation. Wind impacts every facet of your 

flight, just as it would at the local field. 

¶ AccuModelϰ !ƛǊŎǊŀŦǘ 9ŘƛǘƻǊ- RealFlightΩǎ ŀƛǊŎǊŀŦǘ ŜŘƛǘƻr is the most powerful and 

most flexible editor ever introduced in an RC simulator. AccuModel allows you to 
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change virtually every aspect of your model with ease. It places over 1,500 airfoils at 

your disposal, a multitude of propellers, and much, much more! AccuModel brings 

up a wire-frame model for easy reference and highlights the editing area. Make a 

ŎƘŀƴƎŜ ŀƴŘ ƛǘΩǎ ƛƳƳŜŘƛŀǘŜƭȅ ǊŜŦƭŜŎǘŜŘ ƻƴ-screen, ready for review and revision. 

¶ Flying Sites with over 5,000 square miles to explore- wŜŀƭCƭƛƎƘǘΩǎ ¢ǊǳŜ[ƛŦŜ ¢ŜǊǊŀƛƴϰ 

goes beyond the limitations of traditional simulator flight. Created and mapped from 

satellite imagery, RealFlight 9.5Ωǎ ƭŀƴŘǎŎŀǇŜ ƭƻƻƪǎ ŀǎ άǊƛƎƘǘέ ŀƴŘ ǊƛŎƘƭȅ ǾŀǊƛŜŘ ŀǎ ǘƘŜ 

view from your front door. Digital elevation data brings it all into accurate 

perspective. 

¶ A living, breathing environment- Everything in RealFlight 9.5Ωǎ о5 ǿƻǊƭŘ ƛǎ ŀǎ ǊŜŀƭƛǎǘƛŎ 

as possible; complete with depth and details that transcend the traditional 

άōƛƭƭōƻŀǊŘέ ƭƻƻƪ ƻŦ ƻǘƘŜǊ ǎƛƳǳƭŀǘƻǊǎΦ ̧ ƻǳΩƭƭ ǎŜŜ ƭŜŀǾŜǎ ŀƴŘ branches that dance in a 

passing breeze and clouds that roll by with the prevailing winds. 

¶ FlexiFieldϰ ŦƭȅƛƴƎ ǎƛǘŜ ŜŘƛǘƻǊ- ¢ƘŜ CƭŜȄƛCƛŜƭŘϰ ŜŘƛǘƻǊ ǘŀƪŜǎ ȅƻǳ ōŜȅƻƴŘ н5 ǎŎŜƴŜǎ ƛƴǘƻ 

a 3D environment rich in new objects and editing options. Customize an existing field 

with new foliage, different objects, or both. Create a new field with nothing more 

than a mouse, imagination and a few simple keystrokes. 

¶ InterLink DX Controller- Modeled after Spektrum transmitters, RealFlightΩǎ Spektrum 

InterLink DX controller functions as a controller, or an interface. This new unit is 

capable of resetting and rewinding the aircraft, or hand-launching a sailplane. 

Additionally, the InterLink DX is the key to navigating the QuickSelect menus ς select 

alternative aircraft, flying sites and more, all from the controller. 

¶ VirtualRevolutionϰ sound technology- Doppler-correct stereo sounds heighten the 

realistic effect with true sound recordings of 2-stroke, 4-stroke, turbine, electric, 

ducted fan and gasoline engines. As the aircraft crosses the field, the engine sound 

follows, just like its RC counterpart.  

¶ RotoSonicsϰ technology- Recreating distinctive engine/blade sounds with startling 

accuracy. ¢ƘŜ ǎƻǳƴŘǎ ŀǊŜ ǎƻ ƭƛŦŜƭƛƪŜΣ ȅƻǳΩƭƭ ǎǿŜŀǊ ȅƻǳ ŀǊŜ ŀǘ ǘƘŜ ŦƛŜƭŘΗ 

¶ AFR (Advanced Flight Recorder)- This feature allows the pilot to not only view 

prerecorded maneuvers, but also to record maneuvers of his/her own as well. 

RealFlight even allows you to record your own audio for personalized flight 

instruction. This feature also allows you to pause, speed up, slow down, and loop the 

performance. The pilot has the option to activate the digitized transmitter display, so 

that he/she can view the radio input while flying. 

¶ NavGuidesϰ- Using the NavGuides, you can display a variety of heads-up on-screen 

information. Options range from altitude and airspeed to aircraft heading and engine 
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RPM. ¢Ƙƛǎ ŦŜŀǘǳǊŜ ƛƳǇǊƻǾŜǎ ȅƻǳǊ ŀōƛƭƛǘȅ ǘƻ άǎŜŜέ ǿƘŀǘ ƛǎ ƎƻƛƴƎ ƻƴ ƛƴ ȅƻǳǊ ǾƛǊǘǳŀƭ 

world. 

¶ Viewport- You can open up a picture-in-picture display and treat it as an 

ƛƴŘŜǇŜƴŘŜƴǘ άǿƛƴŘƻǿ ƻƴ ǘƘŜ ǿƻǊƭŘέΦ ¸ƻǳ Ŏŀƴ ƛƴŘƛǾƛŘǳŀƭƭȅ ŀŘƧǳǎǘ ŜŀŎƘ ƻŦ ǘƘŜ 

ǾƛŜǿǇƻǊǘΩǎ ǾŀƴǘŀƎŜ ǇƻƛƴǘǎΣ ȊƻƻƳ ƭŜǾŜƭΣ ŀƴŘ ŘƛǊŜŎǘƛƻƴ ƻŦ ǾƛŜǿΦ 

¶ Multiplayer- You can fly with many other RealFlight 9.5 owners. Participate in online 

competitions, or just enjoy the thrill of flying around with one another. This feature 

can also be used to learn new maneuvers from pilots across the street or around the 

world. 

¶ Combat Events- Compete in Streamer Cut, Paintball, Rocket and Machine Gun 

combat. hǊ ŎƻƳōƛƴŜ ǊŀŎƛƴƎ ŀƴŘ ŎƻƳōŀǘ ƛƴ ŀƴ ŜȄŎƛǘƛƴƎ ƳŀǘŎƘ ƻŦ 5ŜŀŘwƛƴƎŜǊϰΦ Plug in 

a headset and microphone to your computer and chat live during these contests. 

¶ Animated control surfaces and retracts- Control surfaces, retracts, propellers, and 

rotor blades move for added realism. 

¶ Aircraft exhaust/smoke- ̧ ƻǳ Ŏŀƴ ŎƻƴǘǊƻƭ ǘƘŜ ŎƻƭƻǊΣ ŘŜƴǎƛǘȅΣ άƘŀƴƎ ǘƛƳŜέΣ ŀƴŘ ƻǘƘŜǊ 

parameters related to airplane and helicopter smoke and exhaust. 

¶ Streamers- Add streamers to any aircraft, to any location, in any color. Watch as they 

corkscrew behind the airplane during a roll, or react accordingly to the wind and the 

propwash. 

¶ Flight Failures- RealFlight can simulate many common flight failures (radio 

interference, stuck servos, engine failures, etc.). Use this feature to prepare for 

emergencies at the field. 

¶ Fully editable aircraft paint/decal schemes- Create customized trim schemes for 

your aircraft. (To design your own paint scheme, you must use a third-party program 

that edits TGA files.)  

¶ Launcher- RealFlightΩǎ [ŀǳƴŎƘŜǊ ŀƭƭƻǿǎ ŦƻǊ Ŝŀǎȅ ƻƴŜ-click access to program 

upgrades, the RealFlight 9.5 manual, and technical support.  [Only applicable to DVD 

and Tower Hobbies Digital versions only.] 

¶ Extensive Help materials- RealFlight features extensive online tool tips and diagrams, 

a detailed manual, and technical support to enhance your enjoyment of the program. 
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How to read this manual 

RealFlight 9.5 is a menu-driven program, which allows you to make quick changes without 

having to reload the simulator each time. This manual will break out each main menu to its 

own chapter. This allows you to quickly find information on features and functions by the 

related menus. 

Along with this manual, a large RealFlight community is available online to help and discuss 

any topics with each RealFlight fan. This online support, in the form of a forum, can be found 

at: 

https://www.knifeedge.com/forums/ 

 

https://www.knifeedge.com/forums/
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Before You Begin 

TO GET THE MOST OUT OF REALFLIGHT 9.5, IT HELPS TO FIRST UNDERSTAND 

HOW TO GET THE MOST OUT OF YOUR COMPUTER. 

 

ealFlight 9.5 is designed to work on a large variety of computer hardware. Similar to a 

car, if you want to go faster, you need a bigger engine. The same holds true with 

wŜŀƭCƭƛƎƘǘΦ ¸ƻǳΩƭƭ ōŜ ŀōƭŜ ǘƻ ŜƴƧƻȅ ǘƘŜ ǎƛƳǳƭŀǘƻǊ ƻƴ Ƴƻǎǘ modern computers, but 

having the most up to date hardware for your computer will greatly increase your 

enjoyment. 

System Requirements 

You will find the suggested system requirements for the RealFlight 9.5 RC Flight Simulator 

listed below. The minimum recommended system requirements are the bare minimum PC 

configuration for installing RealFlight 9.5. Meeting the minimum requirements will allow you 

to enjoy RealFlight 9.5. However, in order to take complete advantage of the many features 

and functions offered by RealFlight 9.5, you should have a computer that meets or exceeds 

the specifications as specified in the optimum system requirements. 

Minimum Recommended System- 

- Some graphical features may be disabled 

- Aerodynamic Calculations will still be high-quality 

Windows* 7, Windows* 8 or Windows* 10 

  *Administrator Access Required 

Intel Pentium 1.0GHz or equivalent 

512 MB RAM 

10 GB Hard Drive Space 

DVD Drive [DVD version only] 

Broadband Connection [Steam or Digital Version, and multiplayer] 

3D Accelerated Video with:  

Chapter  

2 
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- 32 MB Dedicated Video Memory 

- Full DirectX 9 compliant (Shader Model 2.0 or better) 

Available USB 2.0 port 

Optimal System- 

- For best graphical performance 

Dual Core 2.4GHz CPU 

2 GB RAM 

3D Accelerated Video with: 

- 512 MB dedicated video memory 

Multiplayer Requirements- 

Broadband connection 

Computer microphone for voice chat 

Virtual Reality Headset- 

Please refer to the system requirements necessary to support your device. 

Video and Sound Cards 

In order to achieve optimum performance and the best flying experience in RealFlight, there 

are two important components of your computer that deserve special attention: the video 

and sound cards. 

RealFlight 9.5 has undergone countless hours of compatibility testing and evaluation. As 

such, this software will adequately function with a variety of video cardsτranging from 

yestŜǊŘŀȅΩǎ ŦŀǾƻǊƛǘŜǎ ǘƻ ǘƻƳƻǊǊƻǿΩǎ ƘƛǘǎΦ 

While RealFlight works well on a wide variety of hardware configurations, it offers many 

features and functions that are designed to take particular advantage of the latest video 

technology. If you have an older computer, or a newer computer with a lower-end video 

card, you may want to consider purchasing a new video card to take advantage of these 

features and functions. This moderately priced upgrade can vastly enhance your enjoyment 

of RealFlight. Aside from increasing your satisfaction with RealFlight 9.5, a new video card will 

also work with many other games or simulators, improving their performance as well. 

While not as important as the video card, upgrading your sound card may also improve your 

satisfaction with RealFlight. This is especially true if your computer uses an on-board sound 

card (a sound card affixed to the motherboard). 
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Getting the Most out of RealFlight 

²Ŝ ǘƘƛƴƪ ȅƻǳΩƭƭ ŀƎǊŜŜ ǘƘŀǘ wŜŀƭCƭƛƎƘǘ ƻŦŦŜǊǎ ǘƘŜ ŦƛƴŜǎǘ ǎŜǘ ƻŦ ƛƴǎǘǊǳŎǘƛƻƴǎ ŀƴŘ ǇǊŀŎǘƛŎŜ ǘƻƻƭǎ ƻŦ 

any RC simulator suited for both beginners and experienced pilots. Horizon Hobby and Knife 

Edge Software are committed to the continual improvement of our products. When using 

the software, you should keep two things in mind: 

First, similar to other pursuits, what you get out of RealFlight depends upon what you put 

into it. Mastering radio control requires a great deal of patience and practice. If you crash an 

aircraft in the simulation, take it very seriously. Crashing an actual RC aircraft can cost you a 

lot of time and money. Try to identify what you did incorrectly, and use the experience to 

avoid making the same mistake again. 

Secondly, while the simulator is quite realistic and will assist you in learning many of the skills 

necessary to become a proficient pilot, there is no substitute for actual flying time at the 

field. A simulation can be a wonderful practice tool. However, no simulator, no matter how 

realistic, can completely replace a qualified, experienced, human flight instructor. If you are 

new to RC, you should never attempt to fly a real aircraft without the supervision of a 

qualified instructor; no matter how accomplished you are on the simulator. 



 

 

15 RealFlight 9.5 RC Flight Simulator 

 

Getting Started 

A BRIEF OVERVIEW AND ASSISTANCE TO START YOU ON YOUR RC 

ADVENTURE. 

 

his chapter covers the installation procedure for RealFlight 9.5, it describes the basics 

of running the program, and introŘǳŎŜǎ ȅƻǳ ǘƻ ǎƻƳŜ ƻŦ wŜŀƭCƭƛƎƘǘΩǎ ŦǊŜǉǳŜƴǘƭȅ ǳǎŜŘ 

features. 

The first section, Installing RealFlight 9.5, offers a step-by-step approach to the installation 

procedure for both the program software and the controller. 

The second, Using your own RC Radio, offers the instructions you need if you intend to use 

your own RC transmitter to control RealFlight 9.5. If you only wish to fly with the InterLink DX 

controller, you may choose to skip this section. 

Finally, the third section, Exploring RealFlight 9.5, offers a brief tour of the RealFlight 9.5 

program. You'll learn how to perform some basic functions, such as selecting the aircraft you 

wish to fly, performing simple edits to the flying field, enabling helpful gadgets, and 

manipulating viewports. 

This chapter only touches briefly on some of RealFlight 9.5Ωǎ ŦŜŀǘǳǊŜǎΦ We strongly suggest 

that you also read the subsequent chapters, which describe the various features in 

comprehensive detail. 

Installing RealFlight 9.5 RC Flight Simulator 

Regardless of whether you plan to use the InterLink controller by itself, or your own 

Spektrum radio through the built-in transmitter interface, follow the instructions on Program 

Installation in this section. 

Program Installation (DVD)- 

RealFlight 9.5 features a very simple, installation process. After the disc installation has been 

completed there are further steps that must be followed prior to running the program for 

Chapter  
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the first time. This section will explain how to install the RealFlight 9.5 software and 

hardware. Upon completion of this section, you should be able to fly the aircraft on your PC. 

The InterLink DX ŎƻƴǘǊƻƭƭŜǊΩǎ ōǳƛƭǘ-in transmitter interface also allows you to use your own 

Spektrum, or other, RC transmitter to control RealFlight 9.5 should you opt to do so. To 

activate the interface adapter, you will first need to follow the instructions in the section 

below. This section explains how to use the transmitter interface option in the InterLink DX 

controller.  Further, it might be necessary to purchase the optional transmitter interface 

cords- RFL1015- in order to utilize a Spektrum, or other such RC transmitter via the interface. 

Program Installation (Digital Download)- 

If you have purchased the digital download iteration of the RealFlight 9.5 software, you will 

receive a serial number for the software via email.  Additionally, you will receive a link to the 

site for which you are to navigate to download the software accordingly.   

The download is 3.1GB and may require a period of time in which to download.  This time 

will vary depending upon the internet connection speed, etc.   

Follow the onscreen instructions for information on the program installation.  

 Program Installation (Steam®)- 

RealFlight is available on Steam, too.  Accessing via Steam requires the Steam client.  If you 

do not have Steam installed: 

1. In your internet browser, visit: store.steampowered.com/about/ 

2. Click the Install Steam button. 

3. Install Steam using the downloaded file. 

4. Run Steam when prompted. 

5. Log into your Steam account.  If you do not have one, click /ǊŜŀǘŜ ŀ bŜǿ !ŎŎƻǳƴǘΧ 

Installing RealFlight 9.5 (assuming that key is purchased via Local Retailer, Tower 

Hobbies or Horizon Hobby) 

Verify that the Steam client is running and that you are logged into your account. 

1. Select the Games menu item. 

2. Select Activate a Product on Steam. 

3. When prompted, enter your RealFlight 9.5 key into the Product Code field, exactly as it 

appears.  You will receive confirmation that the RealFlight 9.5 program is successfully 

activated.   
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4. Click Finish. 

5. Steam will prompt you to install the software.  Confirm your installation options, and 

click Next. 

6. The installation dialog will close, and the RealFlight 9.5 download will begin.  Progress 

displays at the bottom of the Steam client. 

Update Drivers- 

As mentioned above, before you begin installation, we strongly suggest that you 

update the drivers for both the sound and video cards on your PC. A driver is a 

software program that your computer uses to control hardware devices. Each card 

has its own respective driver. Most problems with installing and using RealFlight, as 

well as many other programs that use Microsoft DirectX, arise from using outdated 

video and/or sound card drivers. 

If you are not sure how to update your drivers, it is suggested that you visit the 

support site associated with the manufacturer of the video and sound cards on your 

PC for information on how to do so.   

Connect the InterLink DX Controller or interface- 

The InterLink DX controller, and the Spektrum Wireless Simulator Dongle use the USB 

(Universal Serial Bus) port, so there is little to do in the way of setup.   The Spektrum 

Wireless Simulator Dongle will be covered in a separate section of this manual.  If this 

is the methodology that you have selected for use in controlling the simulation, 

please refer to this section accordingly. 
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It is imperative that you plug in your controller or interface into the computer first, 

before installing the RealFlight software! 

1. With the software installation procedure complete, firmly plug into an 

available USB port on the PC. You do not have to shut the PC down to plug 

the controller in. 

 

2. Shortly after plugging in, a dialog box should appear on the screen indicating 

that Windows has located a new device and will then automatically install the 

necessary drivers.  

Please note: It is possible that Windows will need to install the appropriate files for 

the InterLink DX or interface to function properly. 
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Changing the throttle stick ratchet- 

The InterLink DX incorporates a smooth throttle operation by default.  This is the 

preferred methodology for many pilots.  If, however, you wish to refine the controller 

to incorporate a ratcheted throttle, the Spektrum InterLink DX makes it easy to do so.   

The InterLink DX has all the physical transmitter adjustments located around the 

gimbal face of each gimbal.  This arrangement allows for quick and easy adjustments 

without taking the back cover off or removing any plugs to access adjustment screws. 

Additional information pertaining to the Spektrum InterLink DX may be found in 

Appendix A of this manual.   

Available adjustments: 

¶ Change the Throttle Ratchet 

¶ Change the Throttle Tension 

¶ Adjust Stick Tension 

Ratcheted Throttle- Smooth Throttle Adjustment- 

 RATCHET: 

¶ Locate the throttle strap adjustment screws on both gimbals.  The ratchet screw 

engages a serrated section of the gimbal, while the tension screw engages a 

strap for smooth tension on the gimbal. 

¶ To engage the throttle tension ratchet, turn the ratchet screw clockwise until 

the ratchet engages. 

¶ To disengage the throttle ratchet, turn the screw counter-clockwise until the 

gimbal moves freely. 

SMOOTH TENSION:  

¶ To engage the throttle tension, turn the respective screw clockwise until the 

tension engages. 

¶ To disengage the throttle tension, turn the screw counter-clockwise until 

the gimbal moves freely.   

Adjust Stick Tension- 

Using a Phillips screwdriver, turn the screws clockwise a small amount to tighten the 

stick tension and counter-clockwise to loosen the stick tension.   

Note: We strongly suggest testing the stick tension while turning these screws to ensure 

that stick tension is not too loose or too tight.  Tightening a screw too much can damage 

the spring.  Loosening the screw too much could cause a spring to fall off, possibly 

resulting in a short-circuit in the transmitter. 
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Control Stick Length Adjustment-               

¶ Using a 2mm Allen wrench, turn the 

screw in the stick counter-clockwise 

to loosen it.  

¶ Make the stick length shorter by 

turning the stick clockwise, or longer 

by turning it counter-clockwise. 

¶ After refining the stick to the desired 

length, tighten the screw in the stick clockwise. 

Mode Change Slider- 

The Spektrum InterLink DX Controller has a unique, patent-pending, slider located on 

the rear of the controller that allows for simple mode changes.  This slider may also be 

ǳǎŜŘ ǘƻ ŎƘŀƴƎŜ ǘƻ ǘƘŜ ΨǉǳŀŘŎƻǇǘŜǊΩ ƳƻŘŜ ǿƘŜǊŜōȅ ǘƘŜ ƳƻŘŜ ǎƴŀǇǎ ōƻǘƘ ǎǘƛŎƪǎ ǘƻ ǘƘŜƛr 

centered position. 

Safety Plug 

The safety plug is installed in the transmitter to 

ensure the mode switch cannot be accidentally 

moved when in the normal throttle mode (non-

centered) positions. 

To remove the plug: 

¶ Grasp the plug by the raised rib and pull straight out. Note: A small flat-bladed 

screw driver may be used to gently pry the plug out if necessary.   

¶ Once the mode has been changed, reinstall the safety plug accordingly. 

¶ Simply open the protective slider door and move the slider to the desired 

position.  All changes happen automatically inside the transmitter. 

Changing the Stick Configuration 

¶ With the safety plug removed, ensure that 

both gimbal sticks are centered.   

¶ Gently push the slider mechanism to the 

desired mode configuration as shown in 

the images to the right.   

¶ Once the mode has been changed, 

reinstall the safety plug. 

¶ bƻǘŜΥ ƛǘ ǿƛƭƭ ōŜ ƴŜŎŜǎǎŀǊȅ ǘƻ ŜŘƛǘ ǘƘŜ ŎƻƴǘǊƻƭƭŜǊΩǎ ƻǇŜǊŀǘƛƻƴŀƭ ƳƻŘŜΣ ƳŀǇǇƛƴƎ ǘƘŜ 

LƴǘŜǊ[ƛƴƪ 5·Ωǎ ǇǊƻŦƛƭŜ ǿƛǘƘƛƴ ǘƘŜ ǎƛƳǳƭŀǘƛƻƴΦ  LƴŦƻǊƳŀǘƛƻƴ ƻƴ Ƙƻǿ ǘƻ Řƻ ǎƻ ƛǎ 

found in the Select Controller section on page 57  

Installing the Software*- 

[*DVD and Digital versions only; NOT Steam iteration] 
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After you have completed installation of the new video and sound card drivers, you 

are now ready to install the RealFlight 9.5 RC Flight Simulator program. 

If you do not own a DVD drive, the software is available as a digital 

download: https://realflight.com/dlrf9.  

1. Before installing the program, make sure to close any 

applications that you are running. This includes virus 

scanning software and other similar background 

applications. 

2. [DVD version only] Insert the first RealFlight disc, labeled 

Disc 1, into the appropriate DVD drive. 

3.  [DVD version only] If Auto-Play is active, setup will begin automatically when 

the DVD drive is closed. Simply click the Install button when prompted. If 

Auto-Play is not active, click Start on the task bar. Next, click Run. In the 

dialog box that appears, type ΨŘΥ\ǎŜǘǳǇΩ όŀǎǎǳƳƛƴƎ ǘƘŀǘ ΨŘΩ ƛǎ ȅƻǳǊ 5±5 ŘǊƛǾŜύ 

and click OK. 

 

Follow the on-screen instructions to complete the setup 

procedure. Please make sure to insert the RealFlight Disc 2, when 

prompted to do so.  Upon completion of the installation, click OK. 
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Starting RealFlight 9.5*- 

[*DVD and Digital versions only; NOT Steam iteration] 

 

1. Double-click the RealFlight 9.5 Launcher located on your desktop. 

2. Type the RealFlight 9.5 software serial number in the appropriate location. 

¢Ƙƛǎ ƛǎ ǘƘŜ ǎŜǊƛŀƭ ƴǳƳōŜǊ ǘƘŀǘ ƛƴŎƭǳŘŜǎ ǘƘŜ ΨR9ΩΦ  Please be sure to enter the 

serial number exactly as it appears, and in the proper on-screen fields. Failure 

to enter the serial number correctly will not allow you to proceed to the next 

step. Once the serial numbers have been entered properly, you will see that 

the OK button will now become active and allow you to continue. 
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3. Click OK. RealFlight will attempt to activate your software. The activation 

process must proceed in order to run RealFlight. If the computer is not 

currently connected to the internet, this activation process will fail to connect 

to the activation server and the following window will appear. 

 

If you do not have internet access on the computer which RealFlight 9.5 is 

installed, follow the on-screen prompts. Write down the serial number and 

activation code that appear and log on to www.realflight.com/RF9activation 

on a different computer to activate RealFlight 9.5. Alternatively, you may 

contact Software Support via email or phone. 

4. Once activated, the RealFlight 9.5 

Launcher will appear. If the software has 

been updated since the creation of this 

DVD, most likely as Horizon Hobby is 

always working diligently to enhance the 

enjoyment of this program, the update 

information will appear below the Run 
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RealFlight button.  Click the Update to 9.XX.XXX to access the latest build.  

After the updated files have been received, click Run RealFlight. RealFlight 

9.5 will start with the default aircraft and default flying site. 

Starting RealFlight 9.5*- 

[*Steam version only] 

1. Run the Steam client, select RealFlight 9.5 in your library, and click the Play 

button.  Select the launch option that best fits your needs.  (If you elected to 

create desktop and/or Start menu shortcuts when installing, those will use 

the most recent launch option selected in the client.) 

2. RealFlight 9.5 will attempt to activate your software. The activation process 

must proceed in order to run RealFlight 9.5. If the computer is not currently 

connected to the internet, this activation process will fail to connect to the 

activation server and the following window will appear. 

 

 
 

If you do not have internet access on the computer which RealFlight 9.5 is 
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installed, follow the on-screen prompts. Write down the serial number and 

activation code that appear and log on to www.realflight.com/RF9activation 

on a different computer to activate RealFlight 9.5. Alternatively, you may 

contact Software Support via email or phone. 

3. After activating successfully, RealFlight 9.5 will start with the default aircraft 

and default flying site; the E-flite Habu STS 70mm EDF (4S) and Eli Field. 

Using Your Own RC Radio 

The RealFlight interface requires you to fly in the simulator using your own RC transmitter. 

Alternatively, if you purchased the RealFlight 9.5 .5InterLink DX controller, it offers several 

different modes of operation. .ȅ ƛǘǎŜƭŦΣ ƛǘ ǎŜǊǾŜǎ ŀǎ ŀ ǊŜŀƭƛǎǘƛŎ ΨǎǘŀƴŘ ŀƭƻƴŜΩ ŎƻƴǘǊƻƭƭŜǊ ƻǊ 

joystick. Alternatively, it has a built-in interface that lets you use your own RC transmitter, 

such as a Spektrum transmitter, to control RealFlight 9.5.  

Follow these instructions if you intend to use your own RC transmitter to control RealFlight 

9.5. If you do not want to use your own transmitter, you may skip this section. 

Connecting Your Transmitter to the InterLink DX- 

You can use your RC transmitter to control RealFlight 9.5 by connecting it to the InterLink DX 

ŎƻƴǘǊƻƭƭŜǊΣ ΨōǳŘŘȅ ōƻȄΩ ǎǘȅƭŜ όǎŜŜ ŘƛŀƎǊŀƳǎύΦ If you do not already own them, we offer 

adapter cords to enable you to connect many popular brands (including Spektrum) to the 

RealFlight simulation.  These optional cords are offered as RFL1015 and may be found at 

your local retailer, or online hobby shop.   

 

Locate the cable input port on the rear of the InterLink DX Controller. Plug one end of the 

interface connector cable into this port. Next, plug the other end of the adapter cable into 
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the buddy box port (a.k.a. trainer jack) of your transmitter. The procedure for doing so 

depends on your transmitter: 

¶ If your transmitterΩǎ ōǳŘŘȅ ōƻȄ ǇƻǊǘ ŘƛǊŜŎǘƭȅ ŀŎŎŜǇǘǎ ǘƘŜ мκуέ ǎǘŜǊŜƻ ǇƭǳƎΣ ƛƴǎŜǊǘ ǘƘƛǎ ŜƴŘ 

directly into the radio. This works for many Spektrum® radios. 

¶ LŦ ȅƻǳǊ ǘǊŀƴǎƳƛǘǘŜǊΩǎ ōǳŘŘȅ ōƻȄ ǇƻǊǘ ǊŜǉǳƛǊŜǎ ǘƘŜ ƳƛŎǊƻ όǎǉǳŀǊŜύ ŎƻƴƴŜŎǘƻǊΣ ǳǎŜ ǘƘŜ 

square adapter cord included with the optional interface adapter cord package. 

Connecting your Transmitter to the RealFlight wired interface- 

Some RealFlight users might have the previously available RealFlight wired interface offering.  

RealFlight 9.5 is backwards compatible and will function adequately with this interface if so 

desired.  The information that follows will facilitate the use of this interface.  Again, it may be 

necessary to purchase the optional transmitter interface adapter cords to do so.   

The USB end of the interface should already be plugged into the computer. Plug the other 

end of the interface cable into the buddy box port (a.k.a. trainer jack) of your transmitter. 

The procedure for doing so depends on your transmitter: 

¶ LŦ ȅƻǳǊ ǘǊŀƴǎƳƛǘǘŜǊΩǎ ōǳŘŘȅ ōƻȄ ǇƻǊǘ ŘƛǊŜŎǘƭȅ ŀŎŎŜǇǘǎ ǘƘŜ мκуέ ǎǘŜǊŜƻ ǇƭǳƎΣ ƛƴǎŜǊǘ ǘƘƛǎ ŜƴŘ 

directly into the radio. This works for many Spektrum® radios. 

¶ LŦ ȅƻǳǊ ǘǊŀƴǎƳƛǘǘŜǊΩǎ ōǳŘŘȅ ōƻȄ ǇƻǊǘ ǊŜǉǳƛǊŜǎ ǘƘŜ ƳƛŎǊƻ όǎǉǳŀǊŜύ ŎƻƴƴŜŎǘƻǊΣ ǳǎŜ ǘƘŜ 

square adapter cord included with the interface adapter package.   

After you have connected your transmitter, you will need to perform a brief setup procedure 

before utilizing it with the simulation. 

1. If applicable, make sure that the transmitter is in FM or PPM mode rather than PCM 

mode. Refer to the manual for your transmitter if you are unsure how to do this.  

bƻǘŜΥ ǿƛǘƘ Ƴŀƴȅ ƻŦ ǘƻŘŀȅΩǎ нΦпDIȊ ǎǇǊŜŀŘ ǎǇŜŎǘǊǳƳ ǊŀŘƛƻǎ ǘƘƛǎ ǎǘŜǇ ƛǎ ǳƴƴŜŎŜǎǎŀǊȅ 

and may be skipped accordingly. 

2. If the transmitter did not power up when the interface cord was plugged into it, turn 

the power switch on at this time. 

3. Next, click the Simulation menu and then highlight the {ŜƭŜŎǘ /ƻƴǘǊƻƭƭŜǊΧ menu 

item. Choose the correct Profile from the drop down option, or create a new one to 

match your radio. For more detail information about this dialog, see page 56. 
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Binding your SLT Transmitter to the RealFlight wireless interface- 

As noted above, we have previously offered a wireless transmitter interface compatible with 

equipment that offered the SLT protocol.  This was created to allow the use of Tactic® 

branded transmitters in the simulation.   

If you own this piece of equipment and will be using a Tactic-branded transmitter, the 

wireless interface should already be plugged into the computer. With your Tactic® 

transmitter turned on, following these steps to bind your radio to the RealFlight 9.5 RC Flight 

Simulator. 

1. From the Simulation menu, click the {ŜƭŜŎǘ /ƻƴǘǊƻƭƭŜǊΧ menu item. The following 

window will appear: 

 

2. With your Tactic SLT radio turned on, click the Bind button. 

3. When the red light on the wireless interface turns solid, your radio is bound to 

RealFlight. You should not need to go through this process again, unless you choose 

to use a different radio. 

It is possible that you may still need to edit the radio profile to work with the channel 

mapping of your radio. Please see Select ControllerΧ on page 56 for more information. 

Exploring RealFlight 9.5 

Now that you have completed the installation of the RealFlight program, ƛǘΩǎ ǘƛƳŜ ǘƻ ōŜƎƛƴ 

exploring the program. The following sections will take you on a quick tour of RealFlight 9.5Ωǎ 
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most popular features, such as selecting an aircraft, choosing alternate flying locations, 

customizing the flying sites, and using the training aids instruction. Along the way, we will 

show you where to go for help and how to obtain additional information. 

Even if you are familiar with previous versions of the RealFlight software, you should read 

this section thoroughly. Some features described here are either new, or have been 

completely revised for RealFlight 9.5. 

Start the Program*- 

[*DVD and Digital versions only; Not Steam iteration] 

1. Close all open applications. This includes virus scanning software and other similar 

programs. 

2. Double-click the RealFlight 9.5 Launcher located on your desktop. 

3. To start the simulation, click the Run RealFlight button.  As mentioned previously, if 

there is an update available, this update will appear beneath the Run RealFlight 

button.  We strongly encourage you to update the software each time an update is 

available.   

The program will start by displaying a Welcome Screen. The Welcome Screen allows you to 

select amongst a multitude of options which include, but are not limited to, choosing an 

aircraft, flying site or a scenario (a pre-selected combination of aircraft and flying site), 

receive a lesson, and/or earn challenge medals as desired.  Additionally, at the bottom is a 

large button to allow you to jump directly into RealFlight and start flying immediately.    
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From the Welcome Screen, you can also access a number of helpful videos. The videos will 

walk you through some of the more popular features of RealFlight. For true beginners of RC, 

the training videos are a great place to start, teaching you the basic controls for flight. 

LŦ ȅƻǳΩŘ ƭƛƪŜΣ ȅƻǳ Ŏŀƴ ŘƛǎŀōƭŜ ǘƘŜ ²ŜƭŎƻƳŜ {ŎǊŜŜƴ ōȅ ǳƴŎƘŜŎƪƛƴƎ ǘƘŜ ōƻȄ ƭŀōŜƭŜŘ Show this 

dialog on startup. You may access the Welcome Screen at any time through the Help menu. 

The Main RealFlight Display- 

RealFlight is a menu-driven program. As seen in the picture below, a menu bar appears 

across the top of the RealFlight screen. Those menus contain additional sub-menu items and 

pull-down lists for the related options of the respective menu. These menus allow access to 

the command and control functions for the RealFlight 9.5 simulation. 

Navigating the Menus- 

To access the various menu items, simply highlight and click the mouse on the menu 

that you would like to view. For example, clicking on the Aircraft menu activates the 

sub-menu items for that menu. 

 

This manual includes a separate chapter for each menu title. Later chapters describe 

in detail all of the menu items, sub-menus and options. 

Please note: It is also possible to access many of the features and functions of 

RealFlight 9.5 using hotkeys. Pressing the ΨHΩ key on the keyboard activates the 

Keyboard Commands dialog, which summarizes the available hotkeys. 
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Aircraft Selection- 

When you start RealFlight 9.5 for the first time, you will be piloting E-CƭƛǘŜΩǎ ƛƴŎǊŜŘƛōƭȅ Habu 

STS EDF (4S) electric ducted fan jet. This is the default aircraft for RealFlight 9.5. 

To select a different aircraft, click the Aircraft menu title in the main menu bar. Next, click 

the {ŜƭŜŎǘ !ƛǊŎǊŀŦǘΧ menu item found in the drop-down menu. This activates the Select 

Aircraft dialog (as shown below), which displays a list of available aircraft.  To make it even 

ŜŀǎƛŜǊ ǘƘŀƴ ŜǾŜǊ ǘƻ ǎŜƭŜŎǘ ǘƘŜ Ƴƻǎǘ ǇƻǇǳƭŀǊ ŀƛǊŎǊŀŦǘΣ ǿŜΩǾŜ ǇƭŀŎŜŘ ǘƘŜ ǇƻǇǳƭŀǊ ǎŜƭŜŎǘƛƻƴǎ ƛƴ 

the main RealFlight 9.5 folder.  At the default, there is also a RealFlight Legacy aircraft folder.  

While there are many modelers that like these aircraft, these are selections that may no 

longer be offered for sale (such as the Great Planes P-6E Hawk), or aircraft that have been 

included in a number of previous iterations of the software.  Additionally, if you have created 

a custom model, or imported another RealFlight ǳǎŜǊΩǎ ƳƻŘŜƭ ƛƴǘƻ ǘƘŜ ǎƛƳǳƭŀǘƛƻƴΣ ƛǘ ǿƛƭƭ 

appear in a Custom Aircraft folder accordingly.   
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Each aircraft available is listed along the left-hand side within the selected folder. The icon 

next to each name differs depending on whether the model is an airplane, helicopter, or a 

drone. To select an aircraft from the list, click on the desired aircraft. The selected model will 

ƴƻǿ ŀǇǇŜŀǊ ƛƴ ǘƘŜ wŜŀŘȅ{ŜƭŜŎǘϰ ǇǊŜǾƛŜǿ ōƻȄΦ !ŘŘƛǘƛƻƴŀƭƭȅΣ ǘƘŜ ŀƛǊŎǊŀŦǘΩǎ ŘŜǎŎǊƛǇǘƛƻƴ ŀƴŘ 

information data will appear in the aircraft information pane, which appears just below the 

ReadySelect preview window. 

When you are satisfied with your selection, click OK to return to the simulator using the 

newly selected aircraft. 

Complete information pertaining to the {ŜƭŜŎǘ !ƛǊŎǊŀŦǘΧ menu item is available in Chapter 6 

of this manual, The Aircraft Menu. 

Alternatively, you may use the InterLink DX controller to change aircraft selections. Simply 

press the Scroll Wheel/Select button located on the front of the InterLink DX controller. This 

will bring forth the QuickSelect tabs on the left side of the computer screen and the aircraft 

selection tab, represented as an airplane icon, should be the highlighted tab. If not, rotate 

the Scroll Wheel until the aircraft selection tab is highlighted.  Press the Scroll Wheel/Select 

button once again to bring up the QuickSelect Aircraft Selection dialog box. Roll the Scroll 

Wheel left or right to view the available aircraft. To select an aircraft, simply highlight the 

name and press the Scroll Wheel/Select button once again. You will return to the simulation 

using the newly selected aircraft. Further instructions can be found on page 131. 
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If you wish to exit the Aircraft Selection screen without making any changes, simply press the 

Reset button on the left side of the InterLink DX controller. 

Aircraft Most Recently Used List (MRU)- 

If you have selected any different aircraft previously, you will note that these aircraft appear 

on a list in the Aircraft menu; as shown below. This list is at the very bottom of the menu. 

This list is commonly referred to as a Most Recently Used, or MRU list. It is limited to the 

eight most recently used aircraft. If you wish to fly one of the aircraft from this list, simply 

click on the name of the aircraft in the MRU list. 
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Airport Selection- 

Changing flying sites uses a process similar to selecting an aircraft. To select a new flying 

location, click the Environment menu title. Next, click the {ŜƭŜŎǘ !ƛǊǇƻǊǘΧ menu item found 

in the drop-down menu. This opens the Select Airport dialog. All the airports in RealFlight 9.5 

are initially grouped by their respective location or scene: Archipelago, Flatlands, 

PhotoFields, or Sierra Nevada. 
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Some scenes are preceded by a [+] (plus) and an icon. The [+] (plus) indicates that another 

expansion level (selection) is available to you. To access the complete list of airports for a 

particular scene, either click the [+] (plus) or double-click on the name of the desired scene. 

For example, clicking the [+] (plus) next to the PhotoFields folder reveals all of the 

PhotoFields flying sites available to you. 

To select an airport from the list, click on the desired airport. The selected airport will now 

appear in the preview box. Additionally, an airport description will appear in the information 

pane, which appears just below the preview window. When you are satisfied with your 

selection, click OK to return to the simulator using the new airport selection. 

Navigating the Airport Selection menu using the QuickSelect feature is almost identical to the 

process mentioned previously for selecting aircraft. Only this time, you will select the Airport 

Selection menu, which is represented by a runway icon. With the QuickSelect tabs visible on 

the computer screen, roll the Scroll Wheel/Select to highlight the runway icon. Press the 

Scroll Wheel/Select button to bring forth the available flying sites. Using the same method, 

as described previously for aircraft, select the new airport and press the Scroll Wheel/Select 

button to return to the simulation using this new flying site. 

Airport Most Recently Used List (MRU)- 

If you have previously selected an alternative flying location, it will appear on a list in the 

Environment menu. This list is at the very bottom of the menu and is commonly referred to 

as a Most Recently Used, or MRU list. It is limited to the eight most recently selected 

locations. If you wish to fly at one of these locations, simply click on the respective location in 

the MRU list to load it into the simulation. 
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QuickSelect Tabs- 

If you have the InterLink DX controller, RealFlight 9.5 offers a revolutionary method for 

accessing many features and functions quickly and easily without ever touching the keyboard 

or mouse. There are seven main areas of access available through the QuickSelect tabs. They 

are: Scenario Selection, Aircraft Selection, Flying Site Selection, NavGuides, On-Screen Radio, 

Binocular view, and Viewport. 

To access any of the QuickSelect tabs, press the Scroll Wheel/Select button on the InterLink 

DX controller. This will bring forth the available options on the left side of the computer 

screen. Roll the Scroll Wheel/Select left or right to cycle through the QuickSelect tabs. The 

highlighted tab is the item that is active. To access the active tab, press the Scroll 

Wheel/Select button. 

You can also access the QuickSelect tabs with the mouse by moving the mouse cursor over 

to the left side of the screen. The QuickSelect tabs will appear and you may click on the 

desired icon. 

 

For additional information on how to use the QuickSelect tabs, please refer to the 

information contained in the section entitled QuickSelect- on page 49. 

Some Common Tasks- 

¶ The easiest method of resetting your aircraft to its original takeoff position is to press the 

reset button located on the front of the InterLink DX controller. Alternatively, you can 
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reset the aircraft by pressing the space bar on the keyboard, or by selecting the Reset 

Position menu item, which is located in the Aircraft menu. 

¶ If your aircraft is equipped with smoke, Switch A located on the rear left corner of your 

InterLink DX controller will generally be utilized to activate this feature. 

¶ To zoom in on an aircraft, press the [+] (plus) key on the number pad of the keyboard. 

Alternatively, you may use menu commands to zoom in. To do so, click on the View 

menu and then click on the Zoom In menu item. Each time the [+] (plus) key or the Zoom 

In menu item are pressed or selected, the view will increase incrementally. 

¶ To zoom out of the current view, press the [ς] (minus) key on the number pad of the 

keyboard. Alternatively, you may use menu commands to zoom out. To do so, click on 

the View menu and then click on the Zoom Out menu item. Every time you press [-] 

(minus) key or select and press the Zoom Out menu item, the view will decrease 

incrementally. 

¶ To reset the view to the default zoom level, press the Backspace on the keyboard. 

Please Note: The Zoom keys are not always functional for all camera modes. Press Z or C on 

the keyboard to cycle through the different zoom and camera modes, respectively. 
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Creating a Viewport- 

RealFlight allows you to create an additional picture-in-picture viewport. Once you create a 

new viewport, you may resize or reposition it by dragging the mouse. You can also adjust all 

ƻŦ ǘƘŜ ǾƛŜǿǇƻǊǘΩǎ ǇǊƻǇŜǊǘƛŜǎ ƛƴŘŜǇŜƴŘŜntly of the main window. The viewport may be 

utilized for a variety of applications, such as changing the viewing perspective of your 

simulation. 

To create a new viewport, click the Gadgets menu title followed by the Viewport menu item. 

Alternatively, you Ƴŀȅ ŀƭǎƻ ǇǊŜǎǎ ǘƘŜ Ψ4Ω ƪŜȅ ƻƴ ǘƘŜ ƪŜȅōƻŀǊŘ ǘƻ ŎǊŜŀǘŜ ŀƴ ŀŘŘƛǘƛƻƴŀƭ 

viewport. 

 

To change the vantage point within the active ǾƛŜǿǇƻǊǘΣ ǇǊŜǎǎ ǘƘŜ ΨCΩ ƪŜȅ ƻƴ ǘƘŜ ƪŜȅōƻŀǊŘΦ 

This toggles through the various camera modes, one of which is the cockpit or ǇƛƭƻǘΩǎ 

perspective. Others include: chase view and a fixed viewpoint, or what you would see if you 

were standing at the side of the runway. 

Please note: Depending upon the flying site selected, some of these viewing options may not 

be applicable. 

Also, some aircraft include onboard cameras for additional viewing perspectives. The View 

chapter of this manual contains a thorough explanation of the viewport and camera options. 
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Using Gadgets- 

The RealFlight software includes several gadgets that may be displayed in the main window 

when running the software. A gadget is an on-screen display that provides helpful 

information, or allows you to access to a variety of RealFlight features and functions. 

For example, the NavGuides gadget displays continuously updated information relating to 

ȅƻǳǊ ŀƛǊŎǊŀŦǘΩǎ ŀƭǘƛǘǳŘŜΣ ŀƛǊǎǇŜŜŘΣ ŘƛǊŜŎǘƛƻƴŀƭ ƘŜŀŘƛƴƎΣ ŀƴŘ ƻǘƘŜǊ ŦƭƛƎƘǘ ǇŀǊŀƳŜǘŜǊǎΦ To display 

the NavGuides gadget, click the Gadgets menu title followed by the NavGuides gadget 

located in the drop-down menu. You may also access the NavGuides by pressing the 

ƴǳƳŜǊƛŎŀƭ Ψ1Ω ƪŜȅ ƻƴ ȅƻǳǊ ƪŜȅōƻŀǊŘΦ Alternatively, you may activate the NavGuides through 

the QuickSelect tabs. To do so, press the Scroll Wheel/Select button on the InterLink DX 

controller. Next, roll the Scroll Wheel/Select to highlight the NavGuides icon. Finally, press 

the Scroll Wheel/Select button to activate the NavGuides. 

When you select NavGuides, you should see the NavGuides gadget appear on your screen: 

 

As discussed previously, you can customize the gadgets for personal preference. For 

complete information on how to do so, please refer to the chapter pertaining to the Gadgets 

menu options. 
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Challenges- 

RealFlight offers a large number of challenges to help you test, refine and hone your flying 

skills. As you improve your skills and score well in the challenges, more levels become 

available, each progressing higher in difficulty. 

 

Do well in these challenges, and you may be rewarded for your efforts with new content, 

including new aircraft to fly.  
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Airport Editing- 

RealFlight offers the most powerful, flexible flying site editor ever produced on an RC 

simulation. RealFlightΩǎ CƭŜȄƛCƛŜƭŘ editor allows you to completely customize virtually every 

aspect of your flying sites. 

 

You can add, remove, change the orientation of, or resize virtually every aspect of your flying 

site. You can alter the position and orientation of the ground objects (such as runways) that 

ΨǎƴŀǇΩ ǘƻ the terrainτyou can even have a runway running up a hill! LǘΩǎ ŜǾŜƴ ǇƻǎǎƛōƭŜ ǘƻ 

control lighting, terrain, clouds, fog/haze, and much more. FlexiField provides you with 

almost unlimited freedom to create the flying environment you want. Moreover, when 

ȅƻǳΩve created an airport, you can share it with other RealFlight users. 

To learn more about the FlexiField flying site editor, please refer to the section titled Edit 

/ǳǊǊŜƴǘ !ƛǊǇƻǊǘΧ on page 162. 
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Aircraft Editor- 

RealFlight also includes a powerful aircraft editor, allowing you full control over every aspect 

and parameters for an aircraft. 

 

The Aircraft Editor allows you to make both simple and complex modifications to any 

aircraft. You could simply change the diameter of the wheel on the landing gear, or add new 

wings, streamers, or paintball guns. The possibilities are endless, and you can expect your 

modifications to accurately affect the behavior of your edited aircraft. 

To learn more about the Aircraft Editor, refer to section Edit Current Aircraft on page 134. 

To make simple refinements to the selected aircraft, we suggest utilizing RealFlight 9.5Ωǎ 

Quick Edit feature. ¢ƻ Řƻ ǎƻΣ ǎƛƳǇƭȅ ǇǊŜǎǎ ΨCtrl + QΩ ƻƴ ǘƘŜ ƪŜȅōƻŀǊŘΦ Make the desired 

changes, and then click Save. 

For more information about the Quick Edit feature, see page 149. 
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Multiplayer Contests- 

RealFlight 9.5 offers multiplayer combat events. With an internet connection, you can 

challenge your neighbor next door, friends from the local RC club, or anyone, anywhere in 

the world. 

 

Multiplayer contests include: Fun Fly, Deadringer, Combat, Streamer Cut, Paintball, and 

Rocket Wars on a variety of different aircraft. Up to 32 people can participate in a multiplayer 

session.  Please note that the fluidity of the multiplayer events hinges upon the connection 

(latency, speed, etc.) of the player with the slowest internet capabilities.  If all participants 

have a stable, fast connection the event will be much more enjoyable and exciting. RealFlight 

also offers a way to automate contests into events, so the host can spend more time 

enjoying RealFlight. 

To quickly join a public multiplayer session, click the Multiplayer menu followed by the WƻƛƴΧ 

menu item. On the dialog window that appears, select a multiplayer session from the list and 

click Connect. 

For more information about multiplayer and combat events, check out Chapter 10 on the 

Multiplayer Menu. 
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Keyboard Commands 

Many options throughout RealFlight may be activated quickly by a simple press of a key on 

the keyboard. Below is a list of functions and their related keys. You may also access this list 

ƛƴ ǘƘŜ ǎƛƳǳƭŀǘƻǊ ōȅ ǇǊŜǎǎƛƴƎ ΨHΩ ƻƴ ǘƘŜ ƪŜȅōƻŀǊŘΦ 

Virtual Channels- 

Channel 5   Y 

Channel 6   U 

Channel 7   I 

Channel 8   O 

Channel 9   J 

 

Gadget Commands - 

NavGuide Gadget  1 

Radio Gadget   2 

Binocular Gadget  3 

Viewport Gadget  4 

Variometer Gadget  5 

Multiplayer Gadget  6 

Overhead Gadget  7 

Timer Gadget   8 

Heads-Up Display  9 

Flight Modes Gadget  0 

Console Gadget  ~ 

Chat Gadget   Enter 

View Commands - 

Reset Aircraft   Space 

Zoom Reset   Backspace 

Zoom In   + 

Zoom Out   - 

Quick Look at Windsock Up Arrow 

Quick Look at Ground  Down Arrow 

Fixed Camera   F1 

Nose Camera   F2 

Chase Camera   F3 

Onboard Cameras  F4-F10 

Set Viewport Camera  Ctrl + F1-F10 

Change Camera Mode  C 
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Follow Camera   Shift + C 

Pivot Camera   E 

Orbit Camera   Ctrl + E 

Select Pit Position  X 

Select Previous Pit Position Shift + X 

Select Default Pit Position Ctrl + X 

Change Zoom Mode  Z 

Change Movement Mode Q 

 

Movement Commands ς 

Move Forward   W 

Move Backwards  S 

Move Left   A 

Move Right   D 

Move Slow   Ctrl 

Move Fast   Shift 

Move Very Fast  Shift + Ctrl 

Environment Commands ς 

Increase Wind Direction Home 

Decrease Wind Direction End 

Increase Wind Speed  Page Up 

Decrease Wind Speed  Page Down 

Increase Turbulence  Insert 

Decrease Turbulence  Delete 

Increase Sun Azimuth  Shift + Home 

Decrease Sun Azimuth  Shift + End 

Increase Sun Inclination Shift + Page Up 

Decrease Sun Inclination Shift + Page Down 

Miscellaneous Commands ς 

Take Screenshot  Tab 

Toggle Microphone On/Off V 

Kill Engine   K 

Start/Stop Recording  R 

Look at Next Aircraft  T 

Look at Previous Aircraft Shift + T 

Look at My Aircraft  Ctrl + T 

Remember Aircraft Position P 
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Clear Position   Ctrl + P 

Flight Failures   F 

Quick Load Gadget  Ctrl + F 

Quick Edit Gadget  Ctrl + Q 

Mute/Unmute Audio  M 

Toggle Full Screen Mode Alt + Enter 

View Keyboard Commands H 

Copy Messages to Clipboard Ctrl + C 

Steam Overlay   Shift + Tab 

 

Game Commands ς 

Target Previous Aircraft [ 

Target Next Aircraft  ] 

Clear Target   \ 

Toggle Padlock View  / 

 

Where to Go From Here 

The examples in this chapter only scratch the surface of RealFlight 9.5Ωǎ ǳƴǇŀǊŀƭƭŜƭŜŘ 

capabilities. We encourage you to explore RealFlight using some of the methods below. 

¶ Browse through the menus. Many of the menus are self-explanatory, providing you with 

a more thorough look at the software. LŦ ȅƻǳΩǊŜ ŀŘǾŜƴǘǳǊŜǎƻƳŜΣ ŘƛǾŜ ǊƛƎƘǘ ƛƴ ŀƴŘ ǎǘŀǊǘ 

making modifications to an aircraft or a flying site! LǘΩǎ ŀ ƎǊŜŀǘ ǿŀȅ ǘƻ ƭŜŀǊƴ ƳƻǊŜ ŀōƻǳǘ 

what makes the RealFlight 9.5 RC Flight Simulator tick! 

¶ LŦ ȅƻǳΩŘ ƭƛƪŜ ǘƻ ƭŜŀǊƴ ƳƻǊŜ about a particular menu or item, look it up in the table of 

contents. 

¶ If you would like RealFlight 9.5 to perform a certain function but cannot locate the 

appropriate command, check the index. 

¶ ¦ǎŜ ǘƘŜ IŜƭǇ ƻǇǘƛƻƴ ƛƴ wŜŀƭCƭƛƎƘǘΩǎ IŜƭǇ ƳŜƴǳΦ 

¶ Talk to other RealFlight users at www.knifeedge.com/forums. 
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Controlling RealFlight 9.5 

FLY WITH THE INTERLINK DX, YOUR SPEKTRUM DSM2/DSMX TRANSMITTER, 

OR WITH YOUR OWN RADIO. 

 

he RC transmitter is a key component in all types of RC flying. This unique method of 

control is part of what separates RC from every other type of aviation. Consequently, a 

realistically simulated transmitter is an important key to an authentic simulation of the 

RC experience. 

With this in mind, we at Horizon Hobby are proud to offer many choices to control the 

RealFlight 9.5 RC Flight Simulator software. Our revolutionary USB InterLink DX (U.S. Patent 

#6,842,804 and #7,010,628) controller, is the most popular option. The InterLink DX 

controller was designed from the ground up to meet the needs of the RC purist. We believe 

that no other RC simulator control method goes further to enrich your RC simulator 

experience. 

 

Chapter  

4 

T 
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Wireless Simulator Dongle 

The Spektrum WS2000 Wireless Simulator Dongle (SPMWS2000) is another popular option, 

enabling you to control RealFlight aircraft with your Spektrum DSM2 or DSMX-compatible 

transmitter.   

 

The previously offered RealFlight SLT wireless interface option is also functional with 

RealFlight 9.5.  This allows you to fly using your own SLT transmitter, or a transmitter 

equipped with an AnyLink/AnyLink2 adapter.  

 

Additionally, the previously offered, RealFlight wired interface option allows you to utilize 

RealFlight 9.5 by connecting to your transmitterΩǎ trainer port. 
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Features of the InterLink DX Controller- 

¶ USB compatibility and convenience. The InterLink DX ƻŦŦŜǊǎ ǘƘŜ άǇƭǳƎ ŀƴŘ Ǉƭŀȅέ 

ŎƻƴǾŜƴƛŜƴŎŜΣ άƘƻǘ ǇƭǳƎƎŀōƭŜέ ƛƴǎǘŀƭƭŀǘƛƻƴ ŀƴŘ ǊŜƳƻǾŀƭΣ ŀǎ ǿŜƭƭ ŀǎ ǘƘŜ ƘƛƎƘ-speed digital 

performance made possible by Universal Serial Bus (USB) technology. 

¶ IƛƎƘ ǉǳŀƭƛǘȅ άƳƻŎƪǳǇέ 15 ςchannel transmitter. Use the InterLink DX controller by itself 

as a pseudo RC transmitter, with the controls you expect in a standard RC radio. The 

mockup transmitter features two 2-position switches, five 3-position switches, a rotary 

knob, two sliders, a push-button, and knurled control sticks with adjustable length, 

tension and ratchet availability. 

¶ Built-in transmitter interface. If you so choose, you can use your own FM or FM-

compatible RC transmitter to control RealFlight, using the InterLink DX ŎƻƴǘǊƻƭƭŜǊΩǎ ōǳƛƭǘ-

in interface. You can even switch back and forth between the pseudo controller and your 

own transmitter! Interface adapter cords are available separately that are for use with 

most Spektrum, Tactic, JR and Futaba transmitters. 

¶ QuickSelect menu controls. With the InterLink DXΣ ȅƻǳΩǊŜ ŀōƭŜ ǘƻ ƳŀƪŜ ŀ ǾŀǊƛŜǘȅ ƻŦ 

common adjustments to the simulator (such as selecting a different aircraft or airport) 

without having to touch the keyboard and mouse.  

¶ Easy setup and use. Simply plug it in and go! 

¶ Simulate sophisticated computer radios. The InterLink DX, used in conjunction with the 

RealFlight software, allows you to simulate the programmability (mixing, exponential, 

etc.) of sophisticated computer radios. 

Features of the Spektrum WS2000 Wireless Simulator Dongle- 

¶ ¦{. ŎƻƳǇŀǘƛōƛƭƛǘȅ ŀƴŘ ŎƻƴǾŜƴƛŜƴŎŜΦ ¢ƘŜ ŘƻƴƎƭŜ ƻŦŦŜǊǎ ǘƘŜ άǇƭǳƎ ŀƴŘ Ǉƭŀȅέ ŎƻƴǾŜƴƛŜƴŎŜΦ 

¶ No wires to tether you to the computer. Complete freedom to sit back and enjoy the 

RealFlight experience with your Spektrum DSM2 or DSMX-compatible transmitter. 

¶ Gain confidence in the programming of your applicable Spektrum transmitter. 

¶ Become acquainted with not only the location of the respective switches, buttons, etc. 

ŦƻǳƴŘ ƻƴ ȅƻǳǊ {ǇŜƪǘǊǳƳ ǘǊŀƴǎƳƛǘǘŜǊ ōǳǘ ŀƭǎƻ ǘƘŜ ΨŦŜŜƭΩ ƻŦ ǘƘŜ ǘǊŀƴǎƳƛǘǘŜǊ ƛƴ ȅƻǳǊ hands. 

Features of the RealFlight wireless SLT interface- 

¶ USB compatibility and convenience. The interface offers ǘƘŜ άǇƭǳƎ ŀƴŘ Ǉƭŀȅέ 

convenience. 
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¶ No wires to tether you to the computer. Complete freedom to sit back and enjoy the 

RealFlight experience. 

¶ Compatible with ¢ŀŎǘƛŎΩǎ SLT protocol. Any radio that transmits using the SLT protocol will 

work perfectly with the wireless interface. Radios without SLT can utilize an AnyLink or 

AnyLink2 adapter.  

Features of the RealFlight wired interface- 

¶ USB compatibility and convenience. ¢ƘŜ ƛƴǘŜǊŦŀŎŜ ƻŦŦŜǊǎ ǘƘŜ άǇƭǳƎ ŀƴŘ Ǉƭŀȅέ 

ŎƻƴǾŜƴƛŜƴŎŜΣ άƘƻǘ ǇƭǳƎƎŀōƭŜέ ƛƴǎǘŀƭƭŀǘƛƻƴ ŀƴŘ ǊŜƳƻǾŀƭΣ ŀǎ ǿŜƭƭ ŀǎ ǘƘŜ ƘƛƎƘ-speed digital 

performance made possible by Universal Serial Bus (USB) technology. 

¶ Use your own FM or FM-compatible RC transmitter to control RealFlight. Interface 

adapter cords are included for most Spektrum, Tactic, JR and Futaba transmitters. 

¶ Reset/Rewind ς We brought the best function of the previous InterLink to the RealFlight 

interface with the Reset/Rewind button. With the interface near hand, there is no need 

to reach for the keyboard. 

Start Flying! 

When you start RealFlight for the first time, the software will automatically detect the 

InterLink DX controller. When you close the Welcome Screen, simply add throttle and start 

flying right away.  Note: In order to obtain the best flying experience possible, we strongly 

suggest that you calibrate the InterLink DX controller accordingly.  Information on how to do 

so may be found on page 60 of this manual. 

If you are flying with your own radio with the RealFlight interface, or through the InterLink 

DX, please refer to the Select Controller section on page 56. 

QuickSelect- 

The InterLink DX also offers QuickSelect buttons located on the controller. These buttons 

allow you to make simple changes to the simulator without having to put the controller 

down and reach for the keyboard or mouse. This makes it convenient to change the current 

aircraft and airport, or display popular on-screen gadgets. 

To access the QuickSelect tabs, press the Scroll Wheel/Select to display a number of tabs 

along the left side of the simulator. Roll the scroll wheel to rotate through these options. 

Pressing the Scroll Wheel/Select once again will select the highlighted tab.  Pressing the 

Cancel button on the InterLink DX will exit out of the tabs and hide them. 

_Ref367955750
_Ref367955750
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  Select Scenario 

  Select Aircraft 

  Select Airport 

  NavGuides Gadget 

  Radio Gadget 

  Binocular View 

  Viewport
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When using the QuickSelect buttons in the Select Aircraft or Select Airport dialog screen, 

press the Scroll Wheel/Select to select the highlighted item. Pressing Cancel on the InterLink 

DX will move you up a level, so you can quickly change folders. To exit out of these dialog 

screens without making any changes, simply press the Reset button.  

~ 
 

Look for the icon to the left throughout this manual for suggestions 

on when to use the QuickSelect buttons. 
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The Simulation Menu 

ALLOWS ACCESS TO A VARIETY OF SIMULATION-RELATED FEATURES, 

FUNCTIONS AND OPTIONS. 

 

he Simulation menu gives you access to many simulator related features, such as 

adjusting physics parameters, changing simulator settings, or importing and exporting 

RealFlight files. 

Clicking the Simulation menu will open the drop-down menu as illustrated in the following 

screen shot. 
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Select Scenarioé  

hŦǘŜƴ ǘƛƳŜǎ ȅƻǳΩƭƭ ŦƛƴŘ ȅƻǳǊǎŜƭŦ ǿŀƴǘƛƴƎ ǘƻ Ŧƭȅ ŀ ǇŀǊǘƛŎǳƭŀǊ ŀƛǊŎǊŀŦǘ ŀǘ Ƨǳǎǘ ǘƘŜ ǊƛƎƘǘ ŦƭȅƛƴƎ 

site under the perfect conditions. For example, you may wish to fly a glider along a cliff 

with the winds just right for soaring. RealFlight offers many of these scenarios pre-

configured to save you time. 

 

/ƘƻƻǎƛƴƎ ǘƘŜ {ŜƭŜŎǘ {ŎŜƴŀǊƛƻΧ ƳŜƴǳ ƛǘŜƳ ŦǊƻƳ ǘƘŜ {ƛƳǳƭŀǘƛƻƴ ƳŜƴǳ ǿƛƭƭ ŘƛǎǇƭŀȅ ŀ 

dialog window with many scenario options listed for your convenience. For slope 

soaring along the cliff, you might select Cliffside Soaring to fly the Mistral 3m at the 

Sierra Nevada Cliff airport. 
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~ 
 

Change scenarios by using the InterLink DX. Press the Scroll 

Wheel/Select, then, with the scenario tab highlighted, press the 

Scroll Wheel/Select once again. This will bring up the Select 

Scenario QuickSelect dialog window. Roll the scroll wheel to scroll 

through the scenarios accordingly, use the Scroll Wheel/Select to 

choose a new scenario, or press Reset to resume flying without 

making any changes. 

Manage Scenariosé  

If you wish to create and edit Scenarios to your own tastes, choose Manage Scenarios 

from the Simulation menu. Doing so will display the following dialog: 

 

The list on the left displays all the scenarios currently accessible to you. On the right are 

all the actions that are available to you. They include: 

¶ Create ς This button allows you to create a brand new scenario. 

¶ Edit ς This allows you to make changes to the selected scenario from the list. 

¶ Copy ς If you wish to make a new scenario with the same parameters, select it 

from the list and then click copy. This is a quick way to make a new scenario that 

you like but would like to make only minor changes, instead of creating a new 

one. 
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¶ Rename ς Use this to rename a selected scenario. This option is only available to 

scenarios that you create. You cannot rename stock scenarios. 

¶ Delete ς As the name implies, choose this to delete a scenario. Like rename, this 

is not available if a stock scenario is selected. 

When you click Create or Edit, the following dialog window will appear: 

 

This window allows you to select and change all parameters associated to a scenario. 

They include: 

¶ Airport ς tǊŜǎǎ ǘƘŜ Χ ōǳǘǘƻƴ ǘƻ ŎƘƻƻǎŜ ŀƴ ŀƛǊǇƻǊǘΦ 

¶ Aircraft ς tǊŜǎǎ ǘƘŜ Χ ōǳǘǘƻƴ ǘƻ ŎƘƻƻǎŜ ŀƴ ŀƛǊŎǊŀŦǘ ŦƻǊ ǘƘƛǎ ǎŎŜƴŀǊƛƻΦ 

¶ Color Scheme ς If the aircraft you selected is available in multiple trim schemes, 

you may select the default for this scenario from the drop down list. 

¶ Description ς As the name implies, this field allows you to type up a short 

message that describes the scenario. 

By clicking the Advanced Options, two more parameters will be available to you if you 

choose a 3D airport (not PhotoField). They include: 
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¶ Starting Position ς Some 3D airports have multiple locations from which you can 

start your flight. Choose the location you wish to be the default for the scenario 

from this drop down list. 

¶ Camera Type ς When flying at 3D airports, you have the option to change your 

camera location. You may change the default for your scenario from this drop 

down list. 

Finally, click Save, to save your changes to the current scenario. If you are editing a stock 

scenario, this option is unavailable. Clicking Save As allows you to save under a different 

name. If you wish to quit or return to the Manage Scenarios window without saving any 

changes, simply click the Exit button. 

Select Controlleré 

RealFlight 9.5 is offered in several different iterations, allowing you to control the aircraft in a 

variety of ways. This includes, but is not limited to the InterLink DX or Software Only, 

versions. It is also compatible with previous control methodologies such as those mentioned 

previously.  To assist you, RealFlight includes features to help walk you through setting up 

your choice of controller. 
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After clicking Select ContǊƻƭƭŜǊΧ, a new window appears with all the controllers available to you. 

For many users, you will only see one controller listed. If you happen to have a real transmitter 

plugged into the InterLink DX, for example, your screen may look something like the following: 

 

The controller that is currently in use for flight will have an orange bar next to it as well as 

άό!ŎǘƛǾŜύέ ƴŜȄǘ ǘƻ ǘƘŜ ƴŀƳŜΦ A few options are available to you from this window: 

¶ Profile ς RealFlight allows you to save profiles for the different radios you might want 

to fly with. Choose the profile that best matches your controller from this drop-down 

list. 

¶ Edit ς Clicking Edit on the Active controller will open a new screen that gives you 

ŀŎŎŜǎǎ ǘƻ ƳƻŘƛŦȅ ŀƴŘ ŀŘƧǳǎǘ ǘƘŜ ŎƻƴǘǊƻƭƭŜǊΩǎ ŎƘŀƴƴŜƭǎ ŀƴd other parameters. See 

below for more information. 

¶ Bind ς If you are using the RealFlight SLT wireless interface, you will see that a Bind 

button is available. To bind your radio to the wireless interface, make sure the radio 

is switched On, then click the Bind button.  Note: This is not applicable to the 

WS1000 or WS2000 wireless simulator dongle offerings. 

¶ Calibrate ς To ensure that your controller is properly calibrated to fly aircraft in 

RealFlight, click Calibrate on the Active controller. Additional information about the 

calibration process is found below. 

¶ Refresh ς If, at any time, you plugged in a radio and turned it On while this screen is 

visible, click Refresh to update the list.  Doing so should include your new controller 

method in the controller listings. 
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To switch the Active controller, simply click on an available controller listed. You will see the 

ƻǊŀƴƎŜ ǎŜƭŜŎǘƛƻƴ ōŀǊ ǎǿƛǘŎƘ ǘƻ ǘƘŜ ƴŜǿ ŎƻƴǘǊƻƭƭŜǊ ŀǎ ǿŜƭƭ ŀǎ άό!ŎǘƛǾŜύέ ŀǇǇŜŀǊ ƴŜȄǘ ǘƻ ǘƘŜ 

name. 

There are hundreds of radios that are compatible with RealFlight, but not all of them 

function exactly the same. Some may have a different channel order, or possibly the channel 

input is reversed. To assist you with making, changing and saving these settings, RealFlight 

offers controller Profiles. 

Edit- 

If you wish to use a radio that is not listed in the Profile drop down list, select 

something similar, then click Edit. The following screen will appear: 

 

The four columns visible include: 

¶ Function ς This is the list of channels that RealFlight uses for its aircraft. These 

cannot be modified. Below each function is a bar.  These bars show the 

current value for each input channel. For example, if you move the throttle 

stick on your controller, the associated bar will move. 
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¶ Reverse ς Check this box to reverse the output direction of a channel.  For 

example, if you advance the throttle stick but the throttle bar decreases, 

clicking the Reverse box should mimic this input accurately. 

¶ Type- This indicates the switch, button, etc. that is associated with a given 

channel.  There are three options- proportional, toggle and tri-state.  

Proportional, as the name suggests, indicates that a given channel is 

proportionally controlled in the movement.  Similarly, Channel 8, in an 

aircraft equipped with SAFE/AS3X, offers a tri-state functionality- switching 

amongst SAFE/AS3X offerings accordingly.   

¶ Value ς The bars that appear in this column show the current value for each 

input channel. For example, if you move the throttle stick on your controller, 

the associated bar will move. 

¶ Input Channel ς This is the channel on your radio that is assigned to the 

Function column. 

Using the information from these columns, you can edit the channel lineup to match 

your radio. For example, if your radio outputs the throttle on channel 1, you will 

Ŧƻƭƭƻǿ ǘƘŜǎŜ ǎǘŜǇǎ ǘƻ ŎƻǊǊŜŎǘƭȅ ŀǎǎƛƎƴ ƛǘ ǘƻ wŜŀƭCƭƛƎƘǘΩǎ ǘƘǊƻǘǘƭŜΥ 

1. CƛƴŘ άо ¢ƘǊƻǘǘƭŜέ ŦǊƻƳ ǘƘŜ Function column. 

2. Click the corresponding Input button. 

3. Move the throttle stick to cƻƴƴŜŎǘ ȅƻǳǊ ǊŀŘƛƻΩǎ LƴǇǳǘ ǘƻ ǘƘŜ CǳƴŎǘƛƻƴ. 

Repeat for all other channels you wish to reassign. 

Enable Software Radio Mixes- 

By default, RealFlight will handle all channel mixing in each aircraft. This is the 

simplest method to fly in RealFlight. In this mode, you should not have any mixing 

programmed into your radio, otherwise channels will be mixed twice; once by your 

radio and then by RealFlight. If you wish to use the mixing programmed in your radio, 

uncheck the box Enable Software Radio Mixes. 

Enable Software Radio Dual Rates and Expo- 

Some radios allow you to program the expos and dual rates on your transmitter. If 

you prefer this method, make sure Enable Software Radio Dual Rates and Expo is 

unchecked. 
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If you are flying with the InterLink DX, or with a radio that does not offer this 

functionality, your will want to enable this feature. Then, make sure you assign a 

ŎƘŀƴƴŜƭ ǘƻ ά5 Ele./5ǳŀƭ wŀǘŜǎέ ƛƴ ǘƘŜ ŎƘŀƴƴŜƭ ŀǎǎƛƎƴƳŜƴǘǎ ŀōƻǾŜΦ RealFlight will then 

handle all rates and expos for you. 

Save and Save As- 

After making changes to your controller profile, you will want to save all 

modifications. Note that you cannot make changes to stock profiles that are included 

with RealFlight. If you made changes to a stock profile, the Save button will be 

disabled. Click the Save As button to save the profile under a different name. 

Calibrate- 

Clicking the Calibrate button on the Active controller allows you to adjust and fine-tune the 

controller input for the simulation, so that you will achieve the desired responses. Once 

clicked, the following screen appears: 

 

As directed, place all sticks to their center positions. Click Next when finished. 
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It is imperative to move all of the sticks, knobs, sliders and switches through their complete 

range of motion several times. This is the key to a properly calibrated controller- and thus, 

precision flight. When completed, click Finish. You will now be returned to the Select 

Controller screen with a calibrated controller. 

Virtual Channels- 

Many aircraft that are included with RealFlight, as well as user created aircraft, require 5, 6, 7 

or even 8 channels to completely operate them effectively. Some radios have fewer 

channels. If you are flying with a radio that has fewer channels than the currently selected 

aircraft requires, you can use the keyboard. 

 Channel 5 Key: Y 

Pressing Y will act like a two-position switch. Press the key to flip the switch to its 

opposite position. 

 Channel 6 Key: U 

Pressing U will activate the knob to one extreme or the other, while holding the key 

down will slowly rotate the knob. 

Channel 7 Key: I 

Pressing I will act like a two-position switch. Press the key to flip the switch to its 

opposite position. 
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Channel 8 Key: O 

Pressing O will act like a three-position switch. A quick press of the key will flip the 

switch to one extreme or the other, while holding the key down will place the switch 

to its center position. 

Channel 9 Key: J 

Pressing J will act like a two-position switch. Press the key to flip the switch to its 

opposite position. 

It might help to display the Radio Gadget to view these channels in action and to assist you in 

learning how they function. 

Physicsé 

One of the great benefits of RealFlight is the ability to adjust features and settings that you 

would not be able to do at a real flying field. The Physics setting is one of these great 

features. It allows you to adjust how realistic the flight physics are in the simulator on a 

global ǎŎŀƭŜΣ ƳŜŀƴƛƴƎ ǘƘŀǘ ŀƭƭ ƻŦ ǘƘŜ ǎƛƳǳƭŀǘƻǊΩǎ ŎƘŀǊŀŎǘŜǊƛǎǘƛŎǎ ǊŜŦƭŜŎǘ ǘƘƛǎ ƳƻŘƛŦƛŎŀǘƛƻƴΦ The 

options that are available are as follows: 
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Beginner- 

This setting is perfect for the first time pilot. It reduces the speed of the physics to 

allow a beginner time to react and learn how an aircraft is controlled. At this level, 

you cannot run out of fuel, and crashes are more forgiving. 

Intermediate- 

Crashes are not as forgiving, and aircraft will run out of fuel just as they would at the 

field. 

Realistic- 

By default, RealFlight 9.5 is set to Realistic. As the name implies, this setting 

accurately reflects the flight performance of their real-world RC counterparts. The 

flight physics level for Realistic is very similar to Intermediate. However, you will 

notice that the severity of the stalls has also increased; forcing the pilot to react 

faster to stalls and other similar flight characteristics. 

Custom- 

Custom will be selected if you made changes to the default settings for physics 

speed, flight model, autopilot assist or fuel consumption. If you wish to adjust the 

physics parameters to fit your skill level, click the Custom Tab at the top of the 

Physics gadget. The following options are available. 
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¶ Physics Speed ς Expressed as a percentage, this value controls the time scale 

of the simulation. Reducing the value allows you to create a slow-motion 

effect. This is useful when learning new skills or practicing difficult 

ƳŀƴŜǳǾŜǊǎΤ ǎƭƻǿƛƴƎ ǘƘŜ ŀƛǊŎǊŀŦǘΩǎ ǊŜŀŎǘƛƻƴ ǘƛƳŜΦ 

¶ Flight Model ς This setting can rŀƴƎŜ ŦǊƻƳ ά9ŀǎȅέ ǘƻ άwŜŀƭƛǎǘƛŎέΦ At an Easy 

setting, the aircraft are easier to fly than in real life. This is especially true at 

slow speeds. If set to Realistic, RealFlight 9.5 simulates real life aerodynamics 

in every way, including abrupt loss of lift during an aerodynamic stall. Setting 

the Flight Model to something in between will provide a compromise. 

¶ Autopilot Assist ς This setting improves overall stability of the aircraft. Much 

ƭƛƪŜ ǘƘŜ !ŎǘƛǾŜ CƭƛƎƘǘ {ǘŀōƛƭƛȊŀǘƛƻƴ ŦƻǳƴŘ ƻƴ IƻōōƛŎƻΩǎ NexSTAR, the Autopilot 

Assist will attempt basic wing leveling when you release the control sticks. For 

helis, the Autopilot Assist manages the collective to resist crashes. The 

ǎǘǊŜƴƎǘƘ ƻŦ ǘƘŜ ŀǎǎƛǎǘŀƴŎŜ ƛǎ ƛƴǾŜǊǎŜƭȅ ǇǊƻǇƻǊǘƛƻƴŀƭ ǘƻ ǘƘŜ ŀƛǊŎǊŀŦǘΩǎ ƘŜƛƎƘǘ 

above the terrain, meaning that it will let you mess up a bit but will try to 

keep you from actually colliding with the ground. 

¶ Unlimited Fuel ς This option determines whether or not your aircraft will run 

out of fuel. If selected, the engine will run indefinitely ς assuming, of course, 
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that you do not crash. If disabled, the aircraft will indeed run out of fuel. The 

length of time required to do so is based upon a number of factors including 

the engine utilized and throttle management, just as it would be at the flying 

field. 
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Graphicsé 

Not all computers are created equal. You might find that RealFlight will perform better if you 

reduce the graphics quality of the simulator. Alternatively, if you have a high-end computer, 

you might enjoy the visualizations better by increasing the graphics quality. 

 

At the bottom of the Graphics Quality Settings dialog, you will notice a slider. Moving this 

from Low to Highest will alter the screen shot displayed above the slider, depicting the 

current selection. If you find RealFlight is not performing at its peak, try reducing these 

settings. 

The slider will be set at Custom if you decide to alter individual graphics parameters in the 

Settings dialog. See Settings on page 85 for more information. 
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Flight Failures 

RealFlight offers the ability to simulate common failures for your aircraft. Flight Failures aid in 

teaching you how to remain calm and react appropriately when an actual failure occurs 

during flight. RealFlight 9.5 allows you to determine the types of flight failures that you will 

face, as well as how often these failures will occur. 
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Adjust the Rate of Occurrence- 

To reduce the frequency of flight failures, click on the Simulation menu followed by 

the Flight Failures menu item, and then the Frequency menu item. This brings up a 

sub-menu as shown in the screen below. Once the sub-menu is visible, simply mouse 

click on one of the options in the pull-down menu.  

 

If you do not wish to experience any flight failures, click the Never option in the drop-

down menu or, if you wish to gain a great deal of experience at handling 

emergencies, click the Always option. 
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Selecting the Type of Flight Failures- 

RealFlight allows you to determine the type of flight failures that you will experience 

within the simulation. To do so, click the Simulation menu followed by the Flight 

Failures menu item. Next, select Enable to bring forth the list of available flight 

failures. If an item has a check mark next to it, then that flight failure is enabled. To 

toggle the flight failure, click on it with the mouse.  

 

The options for Flight Failures consist of: 

¶ All- The simulation will utilize all applicable flight failures.  This means that the 

engine might die, the aircraft could experience a structural failure, and so on.   

¶ Kill Engine - The engine will fail or quit in flight, which means that you will 

have to perform a deadstick landing or autorotation. 

¶ Kill Tail Rotor (heli only) ς This failure will cause the tail rotor of the heli to 

stop functioning during flight. 

¶ Radio Interference (FM) - The receiver will experience intermittent radio 

interference during which the servos will behave erratically. 

¶ Radio Lockout (PCM) - The receiver will experience intermittent radio 

dropouts during which the aircraft will fail to respond to control inputs. 
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¶ Radio Range - The receiver will experience interference proportional to the 

distance between the pilot and the aircraft. LŦ ǘƘŜ ŀƛǊŎǊŀŦǘ ƛǎ ŎƭƻǎŜ ǘƻ ǘƘŜ ǇƛƭƻǘΩǎ 

position, the range problems will be minimal, increasing as the aircraft gets 

farther away. 

¶ Servo Stuck - A servo will become fixed, or stuck, in a certain position. 

¶ Structural Integrity ς This failure determines how strong the aircraft is and if 

parts could break off during flight. 

¶ None- No flight failures are activated. 
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Notify - 

This setting allows you to determine if, or when, RealFlight notifies you as to the 

flight failure experienced. 

 

To adjust the settings of this feature, click on the value as indicated in the column to 

the right of the Notify indicator. Your options are: 

¶ After Flight - RealFlight will advise you as to the flight failure experienced 

upon the completion of the flight. 

¶ Before Flight - RealFlight will inform you which flight failure you are about to 

experience before the flight begins. 

¶ Never - RealFlight 9.5 will never advise you as to the flight failure that you 

have experienced, or are about to experience. A little mystery is a good thing. 

¶ On Failure - RealFlight will inform you of the flight failure just as it occurs. 
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Cause Flight Failure- 

This feature causes a flight failure to occur on command. To access this menu item, 

click on the Simulation menu, and then click on the Cause Flight Failure menu item. 

!ƭǘŜǊƴŀǘƛǾŜƭȅΣ ǇǊŜǎǎƛƴƎ ǘƘŜ ΨCΩ ƪŜȅ ƻƴ ǘƘŜ ƪŜȅōƻŀǊŘ ǿƛƭƭ ŀƭǎƻ ƛƴƛǘƛŀǘŜ ŀ ŦƭƛƎƘǘ ŦŀƛƭǳǊŜΦ 
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Setup Failures 

Setup Failures are basic difficulties that, generally speaking, should be detected before you 

ever leave the ground. However, they are often overlooked and occur as a result of a hurried 

modeler. RealFlight 9.5 allows you to familiarize yourself with, and determine the types of, 

setup failures that you will face, as well as how often these failures will occur. 

 

 

Adjust the Rate of Occurrence- 

To reduce the frequency of flight failures, click on the Simulation menu followed by 

the Setup Failures menu item, and then the Frequency menu item. This brings up a 

sub-menu as shown in the screen below. Once the sub-menu is visible, simply mouse 

click on one of the options in the pull-down menu. 

If you do not wish to experience any setup failures, click the Never option in the 

drop-down menu or, if you wish to gain a great deal of experience at handling 

emergencies, click the Always option. 
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Selecting the Type of Flight Failures- 

RealFlight allows you to determine the type of setup failures that you will experience 

within the simulation. To do so, click the Simulation menu followed by the Setup 

Failures menu item. Next, select Enable to bring forth the list of available setup 

failures. If an item has a check mark next to it, then that failure is enabled. To toggle 

the flight failure, click on it with the mouse.  

 

 

The options for Flight Failures consist of: 

¶ All- Selecting this option will engage all of the setup failures on the list meaning 

that you could experience all of these possibilities accordingly.  

¶ Swapped Channel - This failure simulates the effect of inadvertently swapping 

two channels. For example, you may find that your rudder controls the throttle, 

and vice versa. 

¶ Reversed Channel - One of the channels, selected at random, will operate in a 

reversed direction.   

¶ Reversed Servo - The travel direction of one of your servos is reversed. 
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¶ Servo Trim - A servo alters the trim settings, modifying the flight control position.  

For example, the elevator servo trim might be slightly off causing the airplane to 

ascend or descend when it should be flying level. 

¶ Servo Slop - Servo slop may be the result of improper geometry of the linkages or 

the looseness of the servo gears. 

¶ Servo Hysteresis - The time or gap between a servo input from the pilot and the 

movement of the servo on the aircraft. 
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Notify - 

This setting allows you to determine if, or when, RealFlight notifies you as to the 

setup failure experienced. 

 

To adjust the settings of this feature, click on the value as indicated in the column to 

the right of the Notify When indicator. Your options are: 

¶ Never - RealFlight will never advise you as to the flight failure that you have 

experienced, or are about to experience. A little mystery is a good thing. 

¶ On Reset - RealFlight will inform you of the failure when you reset the flight 

(hitting the spacebar or Reset button on the controller). 
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Cause Setup Failure- 

This feature causes a setup failure to occur on command. To access this menu item, 

click on the Simulation menu, and then click on the Cause Setup Failure menu item.  

Alternatively, you may also simultaneously press the Control and Spacebar keys 

accordingly. 
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Import 

The Import menu item allows you to import content created by other users. There are 

several types of files that are associated with RealFlight.  Each of these file types will be 

covered in the section that follows. 

 

KEX- 

Knife Edge Software has created a plug-in, or software module, that functions with 

popular 3D modeling tools to create subject matter for the RealFlight software.  

The KEX importer is used to bring the model from the plug-in into the simulation 

itself. 

For more information, see: www.knifeedge.com/KEmax/ 

Motor Sound Profile- 

RealFlight allows you to import your own unique sounds for motors that might not 

already exist in the simulator. By recording the sound of the motor at different RPMs 

and importing these recordings into RealFlight, the simulator is able to blend these 

sound files throughout the entire operating range of the motor. 

Raw Panoramic Image- 

This file type refers to the panoramic image that helps generate the PhotoField flying 

sites. This option allows you to create a PhotoField using a panoramic image that you 

may have downloaded or created yourself. It works best with large images 
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(8000x4000 or larger) that are equirectangular, spanning 360 degrees horizontal by 

180 degrees vertical. Click on the wŀǿ tŀƴƻǊŀƳƛŎ LƳŀƎŜΧ selection to import an 

image into the simulation. Browse to the location of the image you would like to 

import. The image may be in any of the bitmap (.bmp), targa (.tga) or a JPEG (.jpg) file 

formats.  

Once you have located the desired image, double-click the image. Select this image 

and click Open. The conversion process can take several minutes for large images. 

When the process is complete, RealFlight 9.5 will automatically create a new 

PhotoField airport that uses your newly imported image. 

To edit the new PhotoField airport (for image alignment, object placement, etc.), 

access the Airport Editor by clicking the Environment menu, followed by the Create 

New !ƛǊǇƻǊǘΧ menu item. To see the image froƳ ǘƘŜ ǇƛƭƻǘΩǎ ǇŜǊǎǇŜŎtive, refer to the 

Pilot Spawn window. Doing so will make it easier to place objects and adjust the 

image correctly as this will be the location for which most flights will be viewed 

accordingly.  If necessary, adjust the image using the Panoramic Image Y Alignment, 

Panoramic Image X Alignment and/or the Panoramic Image Facing options located in 

the Properties window. 

RealFlight Archive (RFX, G3X)- 

RFX is the file extension that is used for all files exported from RealFlight G4 or later 

versions. This menu option allows you to import an RFX file. You will use this for all 

files that you have downloaded. There is nothing special you need to know about the 

file beforehand; the RFX importer handles all types of content, including: planes, 

aircraft, color schemes, airports, PhotoFields, and recordings.  

This menu item also allows you to import the G3X files that were used in the 

RealFlight G3 and G3.5 software iterations. 

After choosing the Import menu item, followed by the RealFlight Archive (RFX, G3X), 

you will be presented with an Open file dialog. Use this dialog to find the file that you 

want to import. Double-click the file or click the file and click Open. The import 

ǇǊƻŎŜǎǎ ǿƛƭƭ ǎǘŀǊǘ ƛƳƳŜŘƛŀǘŜƭȅ ŀƴŘ ƻƴŎŜ ƛǘΩǎ ŦƛƴƛǎƘŜŘ ȅƻǳ ǿƛƭƭ ǎŜŜ ŀ ƳŜǎǎŀƎŜ 

confirming its success. 
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Export 

The Export menu item allows you to share user-created content. It is provided in the 

Simulation menu as a shortcut to using the Manage User Files dialog. 

 

RealFlight users may share the following items: Color Scheme, Aircraft Variant, Entire 

Aircraft, Airport and Panoramic Images. If one or more of these options on the list is grayed 

out, it is because the currently loaded color scheme, aircraft, or airport is part of the 

simulation by default and not available for export.  That is, only custom content creations 

may be exported accordingly. 

Once any of these items are exported, you can then share them with friends or the rest of 

the RealFlight community. The best choice is to upload the files to the RealFlight swap site 

found at: 

http://swappages.knifeedge.com/ 

Color Scheme- 

This option allows you to share the current aircraft color scheme (a.k.a. trim scheme) 

with other RealFlight users. 
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To export a Color Scheme, select the Export menu item followed by the Color 

Scheme option. A save dialog will appear so that you can choose where you would 

like to save the exported color scheme and determine the filename. After saving, a 

message will appear on-screen advising you whether or not the export was 

successful. This message will also list the location and name of the file that was 

exported. 

Aircraft Variant- 

This option enables you to export an aircraft that has undergone structural 

modifications such as lengthened wing span, more prop thrust, different airfoils, etc. 

It is important to note in addition to any wire frame modifications, the Aircraft 

Variant file option also includes any modifications to the aircraft powerplant, 

batteries, etc. 

To export an aircraft variant, select the Export menu item, followed by the Aircraft 

Variant option. A save dialog will appear so that you can choose where you would 

like to save the exported aircraft variant and determine the filename. A verification 

message will appear on-screen advising you whether or not the export was 

successful. This message will also list the location and name of the file that was 

exported. 

Entire Aircraft- 

This option enables you to export the entire contents of an aircraft such as trim 

scheme, structural changes, etc. 

To do so, select the Export menu item followed by the Entire Aircraft option. A save 

dialog will appear so that you can choose where you would like to save the exported 

aircraft and determine the filename. A verification message will appear on-screen 

advising you whether or not the export was successful. This message will also list the 

location and name of the file that was exported. 

Airport- 

This option enables you to export a modified airport. Note that any custom 

panoramic image you may be using with this airport will not be exported. To export 

ŀƴ ŀƛǊǇƻǊǘ ǿƛǘƘ ŀ ŎǳǎǘƻƳ ǇŀƴƻǊŀƳƛŎ ƛƳŀƎŜΣ ǳǎŜ ǘƘŜ ά!ƛǊǇƻǊǘ όƛƴŎƭǳŘŜ tŀƴƻǊŀƳƛŎ 

LƳŀƎŜύέ ƻǇǘƛƻƴΦ 

To export an airport, select the Export menu item followed by the Airport option. A 

save dialog will appear so that you can choose where you would like to save the 

exported airport and determine the filename. After saving, a verification message will 
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appear on-screen advising you whether or not the export was successful. This 

message will also list the location and name of the file that was exported.  

Airport (include Panoramic Image)- 

This option enables you to export an airport along with its custom panoramic image. 

To do so, select the Export menu item followed by the Airport (include Panoramic 

Image) option. A save dialog will appear which allows you to choose where you want 

to export the airport and what you want to name the file. A verification message will 

appear on-screen advising you whether or not the export was successful. This 

message will also list the location and name of the file that was exported.  

Manage User Files 

The Manage User Files menu item allows you to modify the new user content that you have 

added to the simulation. You will find that the Manage User Files menu item is a handy tool; 

it maintains all such files in one, easy to find location. 
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The Manage User Files dialog allows you to copy, rename, delete, or export any 

custom resource that exists in the simulation. It is important to note that the various 

Manage User Files buttons will be inactive until a modification to one of the files 

exists. That is, this menu item is only utilized to modify user-created items. It will not 

allow you to modify any of the default airports or vehicles included in the RealFlight 

9.5 software. 

 

 

Copy- 

This option duplicates the information and data pertaining to the currently selected 

item. For example, if you wish to duplicate a flying site located in the User Files, click 

the Copy button. Once you have copied the file, enter a name for the new item.  

Rename- 

This option is utilized to rename an existing user-created item.  

To do so, highlight the desired item (flying site, etc.) and click Rename. Enter the 

desired name for the item in the dialog provided.  The item will now appear in its 

respective list of offerings with the new name.  Please note that this new name 

replaces the previously existing named item.  That is, only the newly named item will 

appear on the list.  

Delete- 

This option is utilized to delete an item entirely. All files associated with the item will 

be removed from your computer. 

LǘΩǎ ƛƳǇƻǊǘŀƴǘ ǘƻ ƴƻǘŜ ǘƘŀt users are only allowed to delete items which they, or 

other users, have created. You cannot delete default items that are included in the 

software. 

To delete a user-created item, select the item in the User File menu and click Delete. 

If you wish to delete this item, click OK in the verification dialog. Please note: once 

deleted, this resource will no longer be available in the simulation.  

Export- 

This button is used to export the custom content to a file that can be shared with 

others. If you have created interesting or unusual content, we encourage you to 

share your designs with other RealFlight users. The more content that is shared, the 

more enjoyment everyone will experience. 
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To export a user-created item, select the respective item in the User File menus and 

click Export. A verification dialog will appear on-screen advising you whether or not 

the export was successful, and the location and name of the file that was exported. 

You may then publish the exported file to a web site, move it to another computer, 

or email it for others to enjoy. 

Close- 

This button, as the name suggests, is used to close the Manage User Files dialog box 

after all desired refinements have been completed.   
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Mute/Unmute Audio 

At times, you may want to fly without any sound. Choose this menu item to mute the audio. 

Select it again to activate the sounds.  !ƭǘŜǊƴŀǘƛǾŜƭȅΣ ǇǊŜǎǎƛƴƎ ǘƘŜ ΨaΩ ƪŜȅ ƻƴ ǘƘŜ ƪŜȅōƻŀǊŘ ǿƛƭƭ 

also toggle between the mute/unmute audio selections.   
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Settings 

The Settings option is an integral part of the RealFlight 9.5 software. This menu item allows 

you to adjust a multitude of features and functions within the simulation.  

 

To access this menu item, click on the Simulation menu followed by the {ŜǘǘƛƴƎǎΧ menu 

item. The Settings dialog will appear, showing the available options. 
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Audio- 

The Audio settings allow you to adjust the volume levels for the aircraft and various options 

in the simulation. For each type of sound that is adjustable, there are two parameters that 

can be changed. First is the Volume, which is a percentage of the Overall Volume. The second 

is whether the sound should be enabled or muted. Double-click on the Audio name, or click 

on the [+] (plus) to expand the list and show the Audio options. 

 

Overall Volume (%)- 

This parameter, found when the Audio setting is selected, controls the volume for all 

sounds in RealFlight. 

Sound Enabled- 

This will mute or unmute all sounds in RealFlight. Alternatively, you may select the 

Mute/Unmute Audio menu item from the Simulation menu, or simply press M on 

the keyboard to toggle this setting on or off. 
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Application Sounds- 

The Application Sounds section controls the effects and voiceover sounds in the 

simulation. 

 

¶ Effects Volume (%) - This setting adjusts the master volume level for sounds, 

except all voiceovers. 

¶ Effects Enabled - Choosing No for this option will mute all sounds for the 

simulator except for the voiceovers. 

¶ Voiceover Volume (%) ς This setting adjusts the volume level for the voice chat 

during multiplayer sessions. 

¶ Voiceover Sounds Enabled - Choosing No for this option will mute all sounds for 

the voiceovers, etc. in the simulator. 
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Simulation Sounds- 

The Simulation Sounds section controls the various options related to the 

miscellaneous sounds in the simulation. RealFlight allows you to make modifications 

to the various sounds based upon your preferences. 

 

For each type of sound that is adjustable, there are two parameters that can be 

changed. First is the Volume, which is a percentage of the overall volume. The second 

is whether the sound should be enabled or muted. 

The different sound types are: 

¶ Aircraft ς aircraft-related sounds, such as servos. 

¶ Airport ς the ambient sounds around the airport. 

¶ Collision ς the crashing sounds associated with collisions. 

¶ Engine ς the motor and engine sounds. 

¶ Servo ς controls the sounds of all the servo motors. 

¶ Walk ς the walking sound when moving the camera position. 

¶ Wind ς the sound produced by the wind. 
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Camera- 

The camera options are designed to enhance the field of view when utilizing the Keep 

Ground in View zoom mode. For additional information on this option, please refer to the 

View menu chapter of this manual. 

 

Minimum Field of View (deg)- 

This setting determines the absolute minimum field of view when utilizing the Keep 

Ground in View zoom option. 

To adjust the minimum field of view, click the existing value. Next, enter the desired 

value either directly from the keyboard or via the mouse wheel. 

Padlock View- 

With Padlock View enabled, the cockpit camera position will swivel and follow the 

targeted aircraft during multiplayer combat events.  It is not applicable outside of the 

multiplayer combat events. 

Camera Lag (%)- 

¢Ƙƛǎ ŎƻƴǘǊƻƭǎ Ƙƻǿ ǉǳƛŎƪƭȅ ǘƘŜ ŎŀƳŜǊŀ ǊŜŀŎǘǎ ǘƻ ǘƘŜ ŀƛǊŎǊŀŦǘΩǎ ƳƻǾŜƳŜƴǘǎΦ If the lag is 

set to zero, the camera always looks directly at the aircraft. At all other values, the 

camera will have a spring-like reaction to the aircraft during flight. 
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At very high values, the camera hardly ever looks directly at the aircraft, and often 

the aircraft will fly off the screen as the camera tries to catch up. At lower values, the 

effect is very subtle and yet still softens the camera movement enough so that minor 

ŎƘŀƴƎŜǎ ƛƴ ǘƘŜ ŀƛǊŎǊŀŦǘΩǎ ǎǇŜŜŘκǇƻǎƛǘƛƻƴ ŀǊŜ ƳƻǊŜ ƴƻǘƛŎŜŀōƭŜΦ 

Please note: ǘƘŜǎŜ ǎŜǘǘƛƴƎǎ ŀǇǇƭȅ ǘƻ ǘƘŜ άCƛȄŜŘ ±ƛŜǿέ ŎŀƳŜǊŀ ƳƻŘŜ ƻƴƭȅΦ They are 

not applicable to the cockpit, chase, or onboard views. 

Invert Mouse- 

Setting this parameter to Yes will invert the vertical, or up/down movement of the 

mouse when you are in walk mode. 

Chase Camera Distance (ft)- 

This parameter allows you to adjust the distance which the Chase Camera will follow 

the aircraft from behind. Adjusting this value may assist you in Challenges like 

Balloon Burst. 

Challenges- 

The CƘŀƭƭŜƴƎŜǎ ŘƛŀƭƻƎ ŘŜǘŜǊƳƛƴŜǎ ǿƘŜǘƘŜǊ ƻǊ ƴƻǘ ǘƻ ǎƘƻǿ ΨƎƘƻǎǘΩ Ǌǳƴǎ ŘǳǊƛƴƎ ŎƘŀƭƭŜƴƎŜǎΦ  .ȅ 

default, RealFlight will indeed show the ghosted images of the best times within a Challenge.  If 

ȅƻǳ ŘƻƴΩǘ ǿƛǎƘ ǘƻ ǎŜŜ ǘƘƛǎ ƛƳŀƎŜ ƻƴǎŎǊŜŜƴΣ ǎƛƳǇƭȅ ǎŜƭŜŎǘ ΨNoΩ from the drop-down menu. 
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Console- 

The Console option has a number of sub-categories that allow you to perform modifications 

to the messages that appear on-screen while running the simulator. It also offers two 

parameters that affect all of the sub-categories. 

 

Show At Most- 

This numerical value indicates the maximum number of messages that will appear on 

your screen at any given time. When the maximum number is surpassed, an older 

message will be removed and the most recent message will take its place on-screen.  

RealFlight defaults to five as the maximum number.  Our testing indicates that this 

number of messages will not detract users from their flight.  It is possible to increase 

this number to 100, although the screen becomes very busy. 

Clear on Reset- 

This setting controls whether all of the on-screen messages are cleared when the 

aircraft resets. This prevents the screen from becoming cluttered with messages and 

information. 

Using either the mouse or the up/down arrow keys on the keyboard, select Yes 

(messages automatically clear) or No (messages remain on-screen after a reset) from 

the pull-down listings. If using the up/down arrow keys, press Enter to finalize your 

selection. 
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Double-clicking on the Console name or clicking on the [+] (plus) will bring forth the 

following options: 

¶ Instructions 

¶ Notifications 

¶ Warnings 

¶ Errors 

¶ Chat Messages (Sent) 

¶ Chat messages (Received) 

¶ Commands 

Each of the System Messages screens is independently adjustable and may be 

tailored to suit your personal preferences. For information on how to do so, please 

read the following section. 
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Instructions- 

This option determines the settings for the system Instructions messages. To select 

the Instructions options, click on the Instructions name.  

 

Font Size- 

This option allows you to adjust the font size for the messages pertaining to 

the instructions. Please note: this only affects the Instructions. It does not 

affect any other system messages. 

To access the Font Size options, click on the value shown in the respective 

column. The desired values may be input directly from the keyboard or 

modified using the mouse wheel.  The default value of the font size is 22.  The 

simulation allows a minimum font size of 8 and a maximum size of 80. 

  










































































































































































































































































































































































































































































































































































































































